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Welcome to VisualCAD!

VisualCAD 2026
Prefer Printed Documentation? Click Here!

What's New |  Quick Start Play List
On-line help compiled on: Thursday, March 12, 2026

VisualCAD/CAM is a CAD platform that can be used to design a part file. A detailed description of
the product features, User Interface, File Translators, CAD Features, Selection and Transformation
tools is described in the sections below.

Related Topics

The VisualCAD/CAM Screen Layout

VisualCAD/CAM Features Overview

Default Shortcut Keys

Customize VisualCAD/CAM Display

1.1 Features Overview

Here is an overview of the features you will find in VisualCAD/CAM:

General Features

· Ribbon-based menu interface

· Multiple viewport layouts.

· Create, Split, Save, Load and Delete Viewports

· Large display icons for context sensitive toolbars

· Rearrange and dock multiple toolbars inside each other

· (lockable Toolbars - Command Bar, Layer Manager, Property Page, Plug-in
browsers - MOPS Browser, Machining Objects Browser)

· Auto Hide control for all lockable toolbars

· Print Preview and File > Print  

https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2026.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QISEAjFqPkrNRyUTOYw9ZRZ
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· File > Open ... (Browse for VisualCAD/CAM part files)

· Translators include:

VisualCAD Part Files (*.vcp)
VisualMILL Part Files (*.vmp)
VisualTurn Part Files (*.vct)
3D Studio Files (*.3ds)
Adobe Illustrator Files (*.ai)
AMF Files (*.amf)
AutoCAD (*.dxf;*.dwg)
IGES Files (*.igs;*.iges)
LightWave Files (*.lwo)
MecSoft Region Files (*.mrg)
OBJ Files (*.obj)
Parasolid Files (*.x_t;*.x_b)
Point Cloud Files (*.cvs;*.txt;*.asc)
RAW Triangle Files (*.raw)
RHINO 3DM Files (*.3dm)
SAT Files (*.sat)
SketchUP Files (*.skp)
SLC Files (*.slc)
STEP Files (*.stp;*.step)
Stereo-lithography files (*.sla;*.stl)
Universal 3D Files (*.u3d)
VRML Files (*.wrl)

· Save and load C-planes

· Construction Plane (C-Plane) tools - C-Plane to a 3D Face, C-Plane by X-axis, WCS
and more.

· Supports 3D mouse devices from 3Dconnexion

· Auto file save with an option to set the time interval for auto save

· Recovery of file in the event of application crash

· Dynamic view rotates with animation

· Save Viewport layout in the part file

· Assign hot keys for CAD tools on ribbon bar

· Crash Recovery support

Selection Tools

· Selections made easy. Users can select by dragging a window across the
geometry in any of the viewports

· Select by Layer, Color, Type and Name  
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· Invert Selection  

· Select Last Created and Previous  

· Select by geometry types (Points, Lines/Polylines, Arcs/Circles, Polycurves,
Dimensions, Surfaces)

· Rectangular Select

· Selection Mask – To select only certain types of geometries from the viewport

· Selection command to select duplicate objects

Transformation Tools

· Dynamic Move, Rotate  

· Array Geometry - Rectangular and Polar  

· Scaling part geometry on units change

· Graphical transformation of objects using Graphical Manipulator  

· Allow graphical scaling of geometry.

· Scaling using fit to rectangle

CAD Tools

· Coordinate input for geometry creation in World and Construction planes

· Create Points, Lines, Arcs, Curves and curve editing tools

· Point cloud objects

· Create NURBS curves

· Create Text and Text on a Curve  

· Curve creation visual aids

· Curve editing tools

· Surface creation tools.

· Surface Edit Tools (Trim, Project curves to surface, Wrap, Reverse Normal, Unify
Normals, Explode)

· Mesh creation Tools (box, sphere, cylinder, cone, tubes, extrude, revolve)

· Mesh Boolean Tools (Unite, Subtract and Intersect)

· Solid creation tools (box, sphere, cylinder cone, torus, extrude, revolve,
rectangular/circular tube)

· Solid editing tools (Unify Normals, Explode, Stitch)
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· Curve extraction tools – Flat area regions, Create Surface Boundary and section
curves.

· Dimensioning tools (Horizontal, Vertical, Oblique, Radius, Diameter, Angular,
Leader and Annotation text)

· Delete holes/cap holes

· Tool to detect open loops in curve

· Multiple line text input in create Text dialog

· Spell check in text edit box

· Project to C-plane

· Auto Fillet

· Creation of boundary curve when a topologically connected set of surfaces are
selected

· Extend Curve using a distance

· Arc fits on a poly-line

· Corner rounding of a poly-line

· Create silhouette curve around a part or selected geometries parallel to the c-
plane

· Lock layers in layer manager

· Copy one layer to another including all geometry

· Reorder layers

· Hide and un hide objects using Ctrl H and Ctrl Alt H  

· Lock and unlock objects using Ctrl L and Ctrl Alt L  

Related Topics

Welcome to VisualCAD/CAM

The VisualCAD/CAM Screen Layout

Default Shortcut Keys

Customize VisualCAD/CAM Display

1.2 Screen Layout

The VisualCAD screen layout is shown below.  For high resolution displays (4K) the icons are
automatically scaled to match the screen resolution.
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VisualCAD Screen Layout

Related Topics

Welcome to VisualCAD/CAM

VisualCAD/CAM Features Overview

Default Shortcut Keys

Customize VisualCAD/CAM Display

1.3 Quick Access Toolbar

The Quick Access Toolbar is located at the top of the VisualCAD/CAM display.  It contains
commands that you use on a regular basis.  You can add and remove commands to the toolbar to
suite your drawing needs.

The Quick Access Toolbar

Quick Access Toolbar's Default Commands
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 File New / Ctrl+N

 File Open / Ctrl+O

 File Save / Ctrl+S

 Print... / Ctrl+P

Print Preview

Print Setup

 Cut / Ctrl+X

 Copy / Ctrl+C

 Paste / Ctrl+V

 Undo / Ctrl+Z

Undo Multiple

 Redo / Ctrl+Y

Redo Multiple

 Command Recall

 Toggle Continuous Command Recall

 Customize the Quick Access Toolbar

Related Topics

Customize Quick Access Toolbar

VisualCAD/CAM Features Overview

Default Shortcut Keys

Preset <Alt> Accelerator Keys

Customize VisualCAD/CAM Display

1.4 Default Shortcut Keys

VisualCAD/CAM installs with the following keyboard shortcuts preset. You can customize your
keyboard to quickly execute many other VisualCAD/CAM commands using the Customize Quick
Access Toolbar and Customize Keyboard dialogs.

Default Keyboard Shortcuts
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 Point / Ctrl+Alt+P

 New / Ctrl+N

 Open / Ctrl+O

 Save / Ctrl+S

 Print... / Ctrl+P

 Undo / Ctrl+Z

 Redo / Ctrl+Y

 Cut / Ctrl+X

 Copy / Ctrl+C

 Paste / Ctrl+V

 Lock / Ctrl+L

 Unlock / Ctrl+Alt+L

 Hide

Hide Non-Selected / Ctrl+Shift+H

 Show / Ctrl+Alt+H

 Select All / Ctrl+A

 Select None / Ctrl+D

Chain Select / Shift + 

Related Topics

Customize Quick Access Toolbar

Customize Keyboard

Customize the Display

Preset <Alt> Accelerator Keys
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The VisualCAD/CAM Screen Layout

1.5 Options

The Home Ribbon Bar contains the Options pane.  Selecting the icon will display
the Options dialog shown below.  This dialog allows you to set global parameters

which include System, Display, Color, Grid, Lighting, Dimension, Tolerance and Units
preferences. This dialog can also be accessed from the Status Toolbar.

Dialog Box: Options
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Dialog Box: Options

Related Topics

System

Display

Color

Grid

Lighting

Dimension

Tolerance and Units
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Home Ribbon Bar

1.5.1 System

Allows user to set preferences for modeling aids, mouse settings, auto save and
command recall.

Dialog Box: Options > System

Dialog Box: Options > System

Lock Selected Object(s) Drag

If the box is not checked, you can select a geometry object and drag it around the C-
Plane.  When the box is checked, the objects cannot be dragged.
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Mouse Settings

The following Mouse options are supported:

Reverse Mouse Wheel Direction

Reverses the direction of view zooming when using the mouse wheel.

Right Button Action

When Show pop-up menu is selected, performing a right mouse button click in
the view port displays the commands in the pop-up menu.

RMB menu - geometries are not selected

RMB menu - geometries are selected

When Repeat last action is selected, this recalls the previous command.

Pressing and Holding Right Button Action
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This option tells VisualCAD/CAM what to do when the right mouse button is
pressed and held.

· Rotate  
When selected, pressing and holding down the right mouse button from
all views performs a Rotate on the display.

· Depending on Orient View  
When depending on orient view is selected, pressing & holding down
the right mouse button from Top, Front, Right, Left, Back, Bottom views
does a Dynamic Pan of the geometries instead of rotate. For Iso views
(Iso1,2,3 & 4) it performs a Rotate when pressing and holding down right
mouse button down.

AutoSave

The AutoSave function can be used to automatically save your active part file at user-
specified time intervals. AutoSave always saves to the current file name.  This saved file
is removed when you successfully close your model.  

NOTE: Once you activate AutoSave, you will need to
Exit VisualCAD and then launch VisualCAD again before

AutoSave will begin saving your part files!

Under the AutoSave function, check the box next to 'Save every xx minutes' to activate
the AutoSave function.  The time interval can be entered in minutes.

AutoSave saves the file under:
<APPDATA>\MecSoft\VisualCAD 2018\AutoSave where

APPDATA is a logical pointing to a folder set up by your
system administrator.  By default it points to:
C:\Users\<username>\AppData\Roaming\.

Opening an Older Version *.vcp File

Opening an older version vcp file, displays the following dialog allowing you
the opportunity to save the file to the current version.

AutoSave Message

When does AutoSave Prompt me to Save a File?
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Under the following conditions VisualCAD will prompt you to save your file:

1. When you have opened a non-native VisualCAD file.

2. When you have imported a file.

3. When you have created a new part and has not saved the file yet.

When is the AutoSave File Deleted?

Auto save file is deleted under the following scenarios:

1. When the application closes normally.

2. When you close the file either explicitly or by opening another file.

3. When you select not to recover an AutoSave file that was detected on
startup

File Recovery

In the event of a computer crash or if VisualCAD/CAM is terminated abruptly by
ending the process from task manager, VisualCAD/CAM will recover your file if
AutoSave was active and your part file was automatically saved at least once.

If an AutoSave file has been created prior to the crash or termination,
VisualCAD/CAM will detect the file located in the AutoSave folder the next
time it is loaded.  You are then prompted with the following dialog:

AutoSave Message

Selecting Yes, displays the following dialog, prompting you to save your file:

AutoSave Message

This is the only opportunity to recover the part file. If you choose not to
recover it, the AutoSave file will be removed.
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Use Auto Backup

Use this option to back up your VisualCAD/CAM files automatically. You can change the
Auto Backup Path destination directory by selecting the 'browse' button.

If you have the check box checked, then the file is saved ONCE (as soon as the file is
loaded) to the Auto Backup path with the same name as the original path file.  This file is
not deleted on exit so it can be recovered later if necessary.  By default the check box to
Auto Backup is unchecked.

Use Auto Command Recall

When this option is selected, VisualCAD/CAM automatically repeats the last command
without having to go back & reselect the command from the toolbar or use the right
mouse button click or enter option to repeat the previous command.

Use Preselection Highlight

When this option is selected, VisualCAD/CAM automatically highlights selections as the
cursor moves over them.  See Pre-Selection Highlight for more information.

Object Snap Settings

You can control the pixel radius of the object snaps located on the Status Toolbar.  Enter
the Snap Radius desired.

Related Topics

Options

1.5.2 Display

Controls how geometry is displayed.  Select from the following:

Dialog Box: Options > Display
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Dialog Box: Options > Display

General Settings

Turn on Anti-aliasing
A method of smoothing the jagged edges along the lines and curves of text or
graphics. Aliasing is caused by limited display resolution. Selecting this option turns
on Anti-aliasing.

Shading Style
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This controls how smooth surfaces are shaded.

Smooth Shading
Flat Shading

The pictures demonstrate the difference between smooth and flat shading. The left
picture smoothly changes the amount of shading as the surface curves. The right
picture just displays the shading for a flat facet on the surface. Since all surfaces
(including smooth ones) are internally represented as flat facets, flat shading can
affect any surface. The default is smooth shading.

Mesh Edges Display Style

This changes how smooth surfaces are displayed.  Since all surfaces are internally
represented as flat facets, these facets join up along edges.  On smooth surfaces,
these edges are not sharp and are not normally displayed.  An example of a sharp
edge is the edge of a cube.

The pictures demonstrate the difference between silhouette & cusp edges only and
all edge display. The left picture displays only sharp edges (there are none on a
sphere); meanwhile, the right picture displays all the edges. The default is
Silhouette & Cusp Edges Only. When selected, this allows you to select Silhouette
Edges, Cusp Edges or All Edges to display.

Curve Display Style

 This provides an option to turn on or off display of curve start point and direction
arrow.
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Start Point display OFF
Start Point display ON

Curve Direction arrow OFF Curve Direction arrow ON

Selecting Start Point and Curve Direction arrow display under options displays both
start point and curve direction arrow.

Construction Visual Aids Style

This provides an option to choose the display style between Stipple line and Solid
line for visual aids when the Visual Aids is set to active under the status bar.

Stipple line display
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Solid line display

Rendering Options

This can be set to Use Display Lists or Vertex Arrays.  The Vertex Arrays option also
provides the option to Use Video Memory from the video card that is installed on the
computer. The speed and performance varies depending on the operating system
type and video card installed.

View Change Animation

Whenever the view orientation is changed within the active viewport, VisualCAD can
make that orientation change instantly or through smooth animation. If animation is
used, the speed of the animation can be set.

Under the View Change Animation function, check the box next to Speed to activate
the animation.  The animation speed can be controlled using the slider bar.

Ghosted Display Transparency

Whenever the view mode is set to Ghosted Display, you can use this slider to control
the transparency level of the hidden (ghosted) geometry.

Depth Testing

These options allow you to fully display certain objects regardless of the view mode.
 For example, checking the box to Disable Depth Testing for curves, will display all
curves even if the view is set to shaded model.  You can also Disable Depth testing
for grid.  If enabled, the grid lines will always display.

Thickness

Use this parameter to set the display line thickness for all wireframe geometry. Set
this to 1 for the default line thickness. Higher for thicker lines.

Related Topics
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Options

1.5.3 Color

The default colors are set using this dialog.

Dialog Box: Options > Color

Dialog Box: Options > Color

· Screen Background Color  
This allows user to set the viewport background color. This is the color displayed
when no objects are at that position.

· Screen Gradient  
This is a smooth change of lighting.  The direction specified is the lighter side.  It
starts slightly darker on the opposite side of the screen and gradually gets lighter
until it reaches the specified side.

· C-Plane Color  
This changes the color of the construction plane grid.

· C-Plane Grid X Axis Color  
This changes the horizontal axis line of the construction plane.

· C-Plane Grid Y Axis Color  
This changes the vertical axis line of the construction plane.

· Selection Color  
This is the highlight color of objects that have been selected.

· New Layer Color  
This is the default color of objects created on new (not Default) layers.
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· Constr. Visual Aids Color  
This is the default color of construction aids when Visual Aids is set to active in
the status bar.

Related Topics

Options

1.5.4 Grid

This controls how the construction plane grid is displayed.

Dialog Box: Options > Grid

Dialog Box: Options > Grid

Position of Grid Origin

These options will control where the grid is positioned relative to the World
Coordinate System (WCS). 

The grid orientation also carries over to whichever view is active, making
construction easier.
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Center
Move the center of the grid to the WCS.

Move the center of the grid to the WCS.

Lower Left
Move the lower left corner of the grid to the WCS.

Move the lower left corner of the grid to the WCS.

Lower Right
Move the lower right corner of the grid to the WCS.

Move the lower right corner of the grid to the WCS.

Upper Left
Move the upper left corner of the grid to the WCS.
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Move the upper left corner of the grid to the WCS.

Upper Right
Move the upper right corner of the grid to the WCS.

Move the upper right corner of the grid to the WCS.

Pick
Use the button to pick a point on the screen and the origin of the grid will move
to this location.

Notes:

· The point you pick is always on the default XY plane.

· If you use the Upper/Lower options above after using this Pick option,
the offset distance between the WCS and the new origin of the grid
remains in effect.

Move the the origin of the grid to this location.

Other Grid Options
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Grid Extents in X Direction
This controls how many major divisions are displayed along the X axis
direction.  

Grid Extents in Y Direction
This controls how many major divisions are displayed along the Y axis
direction.  

Distance between each Minor Grid Line
This controls the distance between each minor grid line.

Major/Minor Grid Lines

# of Divisions between Each Major Line
This controls the distance between each major grid line. the number of minor
rid line multiplied by the number of major grid lines will determine the overall
extent of the grid.

Major/Minor Grid Lines

Related Topics

Options

1.5.5 Lighting

This controls the characteristics of lighting for the model.  

Dialog Box: Options > Lighting
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Dialog Box: Options > Lighting

There are three types of lighting:  ambient, diffuse, and specular.

Position Light on Top

The scene has a single light source and there are controls for setting its position.  Not
all lighting in the model comes directly from that one source; there is some ambient
light coming in from all over.  The Position Light on Top checkbox must be unchecked
to be able to move the light source.

Ambient

Ambient light comes in from all different directions equally.  Light sources have no
effect on ambient light.  Shadows don’t appear with only ambient light.
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Diffuse

Diffuse light comes from a single source but is scattered in all directions.  Shadows
appear, but there are no “shiny” spots.

Specular

Specular light comes from a single source and is scattered in a single direction.  It is
reflective light.  Shiny metal objects demonstrate good specular reflection.  Shading
is not a significant consideration with specular light.

The three pictures above demonstrate ambient light as the light source moves from
left to right.  There is no effect since ambient light comes from all sides equally.

The pictures above show the effects of the motion of the light source using only
diffuse lighting.  There are no “shiny” spots but yet there is a direction from the light.



VisualCAD 2026 Exercise Guide30

© 2026 Mecsoft Corporation

The last set of pictures uses only specular lighting.  As the light source moves from
left to right, the “shiny” spot follows it.  However, there is nothing else lit up, so the
effect is not just reflective metal.

Related Topics

Options

1.5.6 Dimension

This controls the appearance of dimensioning labels, arrows, and leader lines.

Dialog Box: Options > Dimension

Dialog Box: Options > Dimension

Related Topics

Options
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1.5.7 Tolerance and Units

This controls the accuracy of the model and part units.

Dialog Box: Options > Tolerance and Units

Dialog Box: Options > Tolerance and Units

Tolerances

This controls the accuracy of the models.  Smaller tolerance numbers often result in
significantly big files and slower processing time but are more accurate.

The tolerances are set in a dialog.

Part Faceting Tolerance

Chordal Deviation/Chord Height Tolerance  
The chord height tolerance is used in commands that require approximation
of smooth curves and surfaces.

Curve Hookup Tolerance
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This specifies maximum separation between the endpoints of different
curves when joining them into a single curve.

Units

This converts units from inches to millimeters or from millimeters to inches.  If there
are existing objects, a dialog will appear confirming if you really want to convert the
units.

The objects remain the original size but the coordinate values change.

You can check the box to always prompt you to change the units when files are
opened if they appear not to be in the correct units.  For example, if the system sees
a coordinate value that is quite large such as 500.5, then this dialog will display giving
you the opportunity to change the units to Millimeters.

Related Topics

Options

1.6 View Toolbar

The View Toolbar contains easily accessible commands that control the appearance of the
currently active view.  This includes motion of the camera as well as how objects are displayed.
When a view change is invoked from the View Toolbar toolbar, the existing view magnification
factor is maintained. The View Toolbar is displayed in the currently active Viewport.

The View Toolbar

The View Toolbar

The View Toolbar Displayed in the Active Viewport



Welcome to VisualCAD! 33

© 2026 Mecsoft Corporation

View Toolbar Displays in the Active Viewport by Default

The View Toolbar Commands

Icon Command/Menu Command

Zoom Out

-

Zoom In

Zoom Box

Fit View

Dynamic Pan

Dynamic Rotate

Top View

Iso View
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View Menu

Top View

Front View

Back View

Left View

Right View

Bottom View

Isometric-1,2,3,4

Display Menu

Shaded Display

Toggle Shaded+Edges

Wireframe Display

Toggle Hidden Lines

Ghosted Display

Toggle Parallel/Perspective
Projection

Previous View
These are Undo/Redo View

commands.

Next View

Show/Hide Menu

Hide/Show Grid

Hide/Show WCS

Related Topics
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Zoom Out

Zoom In

Zoom Box

Fit View

Dynamic Pan View

Dynamic Rotate View

Top View

Iso View

Front View

Back View

Left View

Right View

Bottom View

Shaded Display

Toggle Shading + Edges

Wireframe Display

Hidden Line Display

Ghosted Display

Toggle Parallel/Perspective Projection

Hide/Show Grid

Hide/Show WCS

1.6.1 3D Mouse

VisualCAD/CAM supports 3D devices from 3Dconnexion®. It can be customized in
the 3Dconnexion® Properties dialog by selecting the Button Configuration tab.
Button configurations can be set for either the Left mouse button, the Right mouse
button, or both and other buttons depending on the type of 3D device you are
using.

Related Topics

View Tool Bar
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1.7 Customize VisualCAD

The VisualCAD/CAM display can be easily customized to suit your drawing needs.

Customize VisualCAD®

Related Topics

Customize Quick Access Toolbar

Minimize Ribbon Bar

Preset <Alt> Accelerator Keys

Customize Dialog

Customize the Keyboard

Styles Menu

1.7.1 Customize Quick Access Toolbar

You can add/remove commands to the Quick Access Toolbar and perform other User Interface
customization from the Customize Quick Access Toolbar menu.
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Menu: Customize Quick Access Toolbar

Select the indicator  to the right of the Quick Access Toolbar to display the menu:

Displaying the Quick Access Toolbar Manu

Quickly Turn Commands On/Off

Select a command from the menu to "uncheck" it and remove it from the Quick Access
Toolbar.  Selecting it again will add it back to the toolbar.
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Quickly Turn Commands On/Off from the Quick Access Toolbar

More Commands...

You can add more commands to the toolbar by selecting More Commands ... from the
Quick Access Toolbar Menu.  This will display the Customize dialog.  From this dialog you
can also Customize the Keyboard.

Show below the Ribbon

You can move the Quick Access Toolbar to reside below the Ribbon bar by selecting Show
Below Ribbon from the Customize Quick Access Toolbar menu.  You can also do this by
selecting appropriate check box in the Customize dialog.
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Show the Quick Access Toolbat below the Ribbon Bar

Minimize the Ribbon Bar

You can minimize the Ribbon Bar by selecting Minimize the Ribbon from the Customize
Quick Access Toolbar menu.  You can then select one of the tabs to show the Ribbon Bar
as needed.

The Ribbon Bar is shown Minimized

Related Topics

Customize VisualCAD/CAM

Customize Quick Access Toolbar

Preset <Alt> Accelerator Keys

Customize Dialog

Customize the Keyboard

Styles Menu
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1.7.2 Minimize Ribbon Bar

You can minimize the Ribbon Bar by selecting Minimize the Ribbon from the Customize Quick
Access Toolbar menu.  You can then select one of the tabs to show the Ribbon Bar as needed.

The Ribbon Bar is shown Minimized

Related Topics

Customize VisualCAD/CAM

Customize Quick Access Toolbar

Preset <Alt> Accelerator Keys

Customize Dialog

Customize the Keyboard

Styles Menu

1.7.3 Preset <Alt> Accelerator Keys

VisualCAD/CAM installs with Preset <Alt> Key combinations that you can use to quickly execute
the various commands located on each Ribbon Bar.  Refer to topic below for more information.

Using the Preset <Alt> Keys

1. Press the <Alt> key on your keyboard and VisualCAD/CAM will display (and
activate) <Alt> key assignments for the VisualCAD/CAM Menu, Quick Access
Toolbar and each Ribbon Bar.

2. With the <Alt> key pressed, you can then press one of the assigned keys to
execute the command or display the menu or Ribbon Bar.

3. To display (and activate) the <Alt> keys assigned to commands on one of the
Ribbon Bars, first press the <Alt> key combination for the desired Ribbon Bar and
then with the <Alt> key still pressed, press the key assigned to the desired
command.
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4. For example, to execute the Single Line command, press <Alt+C> to display the
Curve Modeling Ribbon Bar and then press <LS> with the <Alt> key still pressed.

The preset <Alt> key assignments for each menu and command are shown below.

Preset <Alt> Keys: Menus

The following preset <Alt> Accelerator key combinations are assigned to commands on
the VisualCAD/CAM Menu, Quick Access Toolbar and Ribbon Bars as shown below.  These
can be displayed in VisualCAD/CAM by pressing the <Alt> key.  

For example, pressing <Alt+A> will automatically display the Modeling Aids Ribbon Bar.

Preset <Alt> Keys: Menus

Preset <Alt> Keys: Home Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Home Ribbon Bar.  

Preset <Alt> Keys: Home Ribbon Bar

Preset <Alt> Keys: Display Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Display Ribbon Bar.  

Preset <Alt> Keys: Display Ribbon Bar

Preset <Alt> Keys: Modeling Aids Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Modeling Aids Ribbon Bar.  
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Preset <Alt> Keys: Modeling Aids Ribbon Bar

Preset <Alt> Keys: Curve Modeling Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Curve Modeling Ribbon Bar.  

Preset <Alt> Keys: Curve Modeling Ribbon Bar

Preset <Alt> Keys: Surface Modeling Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Surface Modeling Ribbon Bar.  

Preset <Alt> Keys: Surface Modeling Ribbon Bar

Preset <Alt> Keys: Solid Modeling Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Solid Modeling Ribbon Bar.  

Preset <Alt> Keys: Solid Modeling Ribbon Bar

Preset <Alt> Keys: Mesh Modeling Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Mesh Modeling Ribbon Bar.  
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Preset <Alt> Keys: Mesh Modeling Ribbon Bar

Preset <Alt> Keys: Dimensions Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Dimensions Ribbon Bar.  

Preset <Alt> Keys: Dimensions Modeling Ribbon Bar

Preset <Alt> Keys: Analyze Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Analyze Ribbon Bar.  

Preset <Alt> Keys: Analyze Ribbon Bar

Preset <Alt> Keys: Transform Ribbon Bar

The following preset <Alt> Accelerator key combinations are assigned to commands on
the Transform Ribbon Bar.  

Preset <Alt> Keys: Transform Ribbon Bar

Related Topics

Customize VisualCAD/CAM

Customize Quick Access Toolbar

Minimize Ribbon Bar
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Customize Dialog

Customize the Keyboard

Styles Menu

1.7.4 Customize Dialog

The Customize dialog shown below allows you to add new command icons to the Quick Access
Toolbar.  From this dialog you can also Customize the Keyboard to execute VisualCAD/CAM
commands quickly.  Refer to the following topics for information.

Dialog Box: Customize

In the dialog shown below, the command icons currently assigned to the Quick Access
Toolbar are listed on the right.  The command icons from the VisualCAD/CAM Menu and
each Ribbon bar are shown on the left.

Dialog Box: Customize

Choose commands from:

Select a Ribbon bar from the drop-down list.  The commands on the selected Ribbon
will be listed in the Commands: window.
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Commands:

This window lists all of the commands on the Ribbon bar selected from the Choose
commands from: list.  Select a command from the list and then pick the Add >>
button to add it to the list on the right.

Add >> / Remove

The Add >> button adds a selected command from the Commands: list on the left to
the list on the right.  The Remove button removes a selected command from the list
on the right. 

Selected Commands List

The list on the right shows all of the commands that are currently being displayed on
the Quick Access Toolbar.  The order of the commands in the list determines the
order of the command icons in on the Quick Access Toolbar.

The icon  to the left of a command in the list indicates that this command has a sub
menu that will also be included on the Quick Access Toolbar.
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Submenu Indicator

  Pick the Up or Down buttons to move a selected command higher (to the
left) or lower (to the right) on the Quick Access Toolbar.  

Reset

Select the Reset button to return the list on the right to the Quick Access Toolbar's
default list of commands. 

Show Quick Access Toolbar below Ribbon

Checking this box will force the Quick Access Toolbar to display below the Ribbon
bar.  You can also do this by selecting Show Below the Ribbon from the Customize
Quick Access Toolbar menu.

Show the Quick Access Toolbat below the Ribbon Bar

Keyboard Shortcuts / Customize

Select the Customize... button to display the Customize Keyboard dialog.  From this
dialog you can then reassign shortcut keys to any command on the various Ribbon
bars.

Related Topics

Customize VisualCAD/CAM
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Customize Quick Access Toolbar

Minimize Ribbon Bar

Preset <Alt> Accelerator Keys

Customize Dialog

Styles Menu

1.7.5 Customize the Keyboard

Invoked by the Customize dialog, the Customize Keyboard dialog shown below allows you to
redefine the Default Shortcut Keys assigned to your keyboard.  Keyboard shortcuts are
combinations of keys that can be pressed to execute a VisualCAD/CAM command.  Pressing the
shortcut keys does the same thing as moving the cursor to the toolbar / menu item and selecting
the command, thus saving time and promotes the continuous flow of your work.

Keyboard shortcuts are also called hot-keys.

Dialog Box: Customize Keyboard

In the dialog shown below, the C-Plane by 3 Points command located on the Modeling
Aids Ribbon bar is being assigned to the keyboard short keys Ctrl+Shift+3.  The dialog also
informs you that those keyboard shortcut keys have not previously been assigned.  Each
section of the dialog is described in detail below.

Dialog Box: Customize Keyboard

Categories:
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This section lists all of the individual panes on each ribbon bars as well as each
ribbon bar.  Select a category and the commands located on that ribbon bar/pane will
be listed on the right within the Commands list. 

Commands:

This section lists all of the commands located on the Ribbon bar or Pane selected
from the Categories section on the left.  Select a command from the list to assign a
new shortcut keys or to reassign its current shortcut keys.

Current Keys:

If the command selected from the Commands list has a shortcut key assigned to it, it
will be displayed in the Current Keys: windows.  This window is for information
purposes and cannot be edited.

Press new shortcut key:

After selecting a command from the Commands:, place the mouse cursor in this field
to activate it.  Then from the keyboard, press the shortcut keys that you want to
assign to the command.  

If the keyboard shortcut keys are currently assigned to another
command, that command is listed under the Assigned to:

section directly below this field.  * If you pick the Assign button, the
shortcut keys will be reassigned!

Assigned to:

If the keyboard shortcut keys you entered in the Press new shortcut key: fields are
currently assigned to another command, that command is listed under the Assigned
to: section.

Set Accelerator for:

This sets the keyboard accelerator.  Currently only Default is available on the list
which sets the accelerator for VisualCAD/CAM.

Description:

After you select a command from the Commands: list a description of the command
is shown under this section.  Refer to the example dialog shown above as a
reference.

Assign / Remove / Reset All

Once you are certain about the selected command and the new shortcut keys, pick
the Assign button to associate them.  VisualCAD/CAM will then execute the
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command when those shortcut keys are pressed.

Related Topics

Customize VisualCAD/CAM

Customize Quick Access Toolbar

Minimize Ribbon Bar

Preset <Alt> Accelerator Keys

Customize Dialog

Styles Menu

1.7.6 Styles Menu

You can select different themes to change how the windows appear.  The borders, colors,
highlighting, and shadowing of standard buttons, dialogs, and windows are controlled by which
theme is selected.

The Styles Menu

Office 2007 Blue

Office 2007 (Blue Style)
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Office 2007 (Blue Style)

Office 2007 (Black Style)

Office 2007 (Black Style)
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Office 2007 (Silver Style)

Office 2007 (Silver Style)

Office 2007 (Aqua Style)



VisualCAD 2026 Exercise Guide52

© 2026 Mecsoft Corporation

Office 2007 (Aqua Style)

Windows 7

Windows 7
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Related Topics

Customize VisualCAD/CAM

Customize Quick Access Toolbar

Minimize Ribbon Bar

Preset <Alt> Accelerator Keys

Customize Dialog

Customize the Keyboard
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Quick Start

VisualCAD 2026
Prefer Printed Documentation? Click Here!

What's New |  Quick Start Play List

Quick Start Guides for each VisualCAD/CAM module are available in both PDF and Video format. 
Refer to the following information to access these resources:

Training Guides (Click on Image to Download)

What's New!

What's New in VisualCAD/CAM 2026

The Complete Quick Start Video Play List

Here is a link to the complete 2026 Video Play List

Related Topics

Find More Resources

https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2026.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QISEAjFqPkrNRyUTOYw9ZRZ
https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCAD-2026-Exercise-Guide.pdf
https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCAD-2026-Companion.pdf
https://mecsoft.com/WhatsNew/WhatsNewInRhinoCAM2026.pdf
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Resource Guide

Download this PDF Guide for a list of the available VisualCAD/CAM Resources.

2025 VisualCAD/CAM Resource Guide

The 2026 VisualCAD/CAM Resource Guide!

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Prefer Printed Documentation? Click Here!

What's New |  Quick Start Play List

https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2026.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QISEAjFqPkrNRyUTOYw9ZRZ
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About this Guide

MecSoft is very excited to provide this FREE 200-page guide to using VisualCAD, MecSoft’s free
CAD program!  VisualCAD can be download as part of VisualCAD/CAM. This guide includes 8
detailed exercises with over 300 detailed graphical illustrations that will get you up and running
with VisualCAD in no time at all!

Here's what's inside:

· Download the completed source files here!

· VisualCAD Preferences  
You will learn about many of the most commonly used system options in VisualCAD
including how to access the online help, set display options, tolerances and units, system
options, viewports and other VisualCAD display functionality.

· 2D Drawing & Dimensioning  
You will learn about the Layer Manager and how to create and work with layers.  You will
also learn how to draw quickly in VisualCAD using the menus and command line shortcuts.
 You will also learn how to take advantage of the Visual Aids feature to speed up your
drawing creating tasks including lines, arcs curves, fillets, chamfers, trimming,
dimensioning and more.

· 3D Modeling  
3D modeling exercises take you deeper into modeling in 3D with VisualCAD.  You will
learn how to draw complex profiles and then extrude and revolve them to build complex
3D features from multiple viewports.  How to use VisualCAD's Graphic Manipulator to
build and position components and features.  You will also learn how to create cross
sections at any point in the 3D model.

· Construction Planes  
You will learn how to use Construction Planes (C-Planes) to navigate and add features and
text to your 3D models.  C-Planes are also critical in learning how to orient imported parts
for machining.  Thus learning how to orient C-Planes and how to orient parts with the use
of C-planes is critical knowledge for all VisualCAD users.

Exercises:

Here is a list of the exercises in this guide:

1. VisualCAD Preferences

2. 2D Drawing & Dimensioning

3. Model a Spanner

4. Model a Base Plate

5. Model a Mold Insert

6. Model a Connector Block

http://www.mecsoft.com/guest/Support%20Documents/VisualCAD_Exercise_Guide_Files.zip
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7. Model a Daisy Decor

8. Using Construction Planes
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#1: VisualCAD Preferences

In this exercise you will learn about many of the most commonly used system options in
VisualCAD including how to access the online help, set display options, tolerances and units,
system options, viewports and other VisualCAD display functionality.

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Access the online help.

2. Set the Display Style.

3. Set the Units to Inches.

4. Set System Options.

5. Set to Quad Viewports.

6. Viewing the Command Prompts.

7. The Status Bar.

5.1 Accessing the Online Help

Accessing the Online Help

At any time you can display the VisualCAD Online Help by selecting this icon or pressing
the <F1> key during any command prompt or by selecting the Help icon shown below.

5.2 Set the Display Style

Set the Display Style
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VisualCAD allows you to change the Style of the display.  At the very top right of the
VisualCAD display window, select the Style drop-down menu and select Office 2007
(Blue Style).

5.3 Set the Units to Inches

Set the Units to Inches

Open VisualCAD and check to see if the part unit is set to Inch.

Status Toolbar

If Units is set to MM, double-click on it to change to INCH.

5.4 Set Systems Options

Set Systems Options

In this exercise you will learn how to set some of the systems options in VisualCAD.

1. Select the Home tab.

2. Now select the Options  icon to display the Options dialog.  This icon is also
located on the Status Bar.

3. Select Tolerance and Units from the left side of the dialog.

4. Under Part Faceting Tolerance set the Chordal Deviation / Chord Height Tolerance to
0.001".

5. Set the Units to Inches.
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System Options Dialog

6. Select System from the left side of the dialog.

7. Under Auto Save, check the box and then set the value to save every 10 minutes. 

8. Check the box to use Auto Backup and then select the ... box to display the Browse
for Folder dialog.

9. Select the folder where you want backup files to be saved and then pick OK.
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10. Set the remaining System Options as shown in the dialog above.

11. Now select Display from the left side of the dialog.

12. Under View Change Animation uncheck the box next to Speed.
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13. Set the remaining Display Options as shown in the dialog above.

14. Select Grid from the left side of the dialog.  In these exercises we use the following
Grid options.
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System Options Dialog

15. Select Dimension from the left side of the dialog.

16. Set the Dimension Preferences to those shown in the dialog below.

17. Pick OK to close the Options dialog.
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5.5 Set to Quad Viewports

Set to Quad Viewports

It is much faster to draw and model in VisualCAD if you have multiple Viewports
displayed.

Select the Home tab.

1. Right-click on the Viewport tab located in the upper left side of the window and
select Quad Viewport.
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2. You can also select Display and Viewport commands from the Display tab of the
VisualCAD Ribbon Bar.
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5.6 The Quick Access Toolbar

The Quick Access Toolbar

Located at the very top left of the VisualCAD window you will find the Quick Access
Toolbar.  It contains many of the most commonly used commands such as Cut, Copy,
Paste, Save, Undo, Redo, etc.  The cool thing is that you can customize this toolpath to
add commands that YOU use regularly.

1. Pick the drop-down menu to the right of the Quick Access Toolbar.

2. Select More Commands... from the menu to display the Customize dialog.  You can
use this dialog to add or remove commands to the Quick Access Toolbar.
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5.7 Viewing the Command Prompts

Viewing the Command Prompts

The Command Input bar  is located just below the ribbon bar.  You
can drag the bar down to see the current and previous command prompts.  This is helpful
while learning how to use VisualCAD. 

1. Move the cursor onto the bottom of the Command Input bar 
 until it changes.

2. Then left-click and drag the Command Input bar  down to reveal
to review the history of commands.
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5.8 The Status Bar

The Status Bar

Located across the very bottom of the VisualCAD display you will find the Status Bar.  It
contains information and quick access to some very helpful commands.  From left to right
on the Status Bar you will find This is where you access the Layer Manager, Properties
dialogs, Graphic Manipulator and more.  Here is the list:
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1. World Coordinates tracker.

2. Units.

3. Grid, Ortho and Object Snaps.

4. Graphic Manipulator.

5. Construction Visual Aids.

6. Properties Manager.

7. Layer Manager.

8. Active Layer Selector.

9. System Options.



VisualCAD 2026 Exercise Guide70

© 2026 Mecsoft Corporation

#2: 2D Drawing & Dimensioning

In this exercise you will learn about the Layer Manager and how to create and work with layers. 
You will also learn how to draw quickly in VisualCAD using the menus and command line
shortcuts.  You will also learn how to take advantage of the Visual Aids feature to speed up your
drawing creating tasks including lines, arcs curves, fillets, chamfers, trimming, dimensioning and
more.

2D Drawing & Dimensioning    

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Create Layers.

2. Curve Drawing.

3. Using Visual Aids.

4. Dimensioning.

6.1 Create Layers

Create new Layers

In this step you will use the Layer Manager to create some new layers and then set the
active layer.

1. Display the Layer Manager.  You can pick the Layer Manager icon  located on the
Status Bar.

2. From the Layer Manager select the Add Layer icon  to add a new layer.
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3. Now lets rename the new layer to Drawing.  First double-left-click in the Name field
to activate it, and enter Drawing as the new layer name.

4. Repeat the procedure to create a new layer, this time named Dimensions.

5. If the Layer Manager keeps Auto-Hiding to the left side of the display, you can select

the Auto Hide pin icon   at the top of the Layer Manager.  to toggle this feature. 
The pin down icon means that the dialog will stay displayed.  The pin left icon
means that the dialog will auto-hide.

6. Now let's change the color of these two layers.  In the Color field left-click on the
color box for the layer named Drawing.  Again, this will display the Colors dialog.

7. From the Colors dialog that displays, accept the default color black by pick OK to
close the dialog.
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8. Repeat the procedure for the layer named Dimensions.

9. Now from the Active column, check the box to make the layer named Drawing as
the Active Layer.

6.2 Curve Drawing

Curve Drawing
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In this step you will learn how to use the keyboard to quickly drawing a polyline and then
create some fillets and chamfers.

1. You only need the Top View  displayed for this exercise so if you have
multiple Viewports displayed, double-left-click on the Top View tab to change the
display to that Viewport.

2. Alternately you can right-click on the Top View tab and select Single Viewport.

3. If you do not see the Top View  tab on any of your Viewports, simply
double-left-click on any viewport tab to set the display to that single Viewport and

then select the Top View  icon from the View Toolbar.

4. For visual purposes, we are displaying the construction Grid and the Grid options are
set to those in the Preferences Exercise.

5. If the Grid is not displayed you can toggle it on by selecting Hide / Show Grid from
the View Toolbar.

6. Scroll the middle mouse button to zoom in/out so that you see the World Origin
WCS triad toward the bottom left of the screen.  If you do not see the X (Red) and Y
(Green) axes displayed, make sure you are in the Top View.
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7. Now we can start curve drawing.  From the Curve Modeling  tab,

select the Polyline  command.

8. The command prompt says:
Polyline:: Pick point or enter coordinates x,y and z
For the start point of the polyline, enter 0,0 in the command window

 and press <Enter>.  

You will see the polyline is starting at the XY origin on the left.

9. For the next point in the Polyline, enter 6,0  and press <Enter>. 
This is in Absolute World Coordinates, 6 units in X and 0 units in Y measured from
the World Origin.
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10. Now if you are drawing and you do not know the exact absolute coordinate values
you can enter Relative Coordinate values in the command window.  

For the next coordinate enter @0,3 in the command window 
 and press <Enter>.  This will place the next point in the polyline 3" from the last
point in the positive Y Axis direction.

Listed below are the absolute and relative coordinate values for the entire polyline.
 Use them to complete the polyline, pressing <Enter> after each coordinate entered.
 If you make a mistake, just Undo and start again.

Polyline Absolute (Relative) coordinate values
0,0
6,0 (@6,0)
6,3 (@0,3)
3,3 (@-3,0)
3,2 (@0,-1)
0,2 (@-3,0)
0,0 (@0,-2)

Your polyline should like this:

Note: In the future you can also specify a point at an angle and length from the
previous point using the following format: @6<45 where the length of the line
segment is 6 and the direction is 45 degrees from the previous point. 

11. Always Save your work!  Select the Save  or Save As  command from
the Home tab or the VisualCAD Main Menu or press <Ctrl+S>. 
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12. Now let's add some fillets.  From the Curve Modeling  tab select the

Fillet  command.

13. For the fillet radius, enter 0.5 in the command window and press <Enter>.

14. For the two lines to fillet, select the lines marked in the illustration below.  For
filleting it is best to select the line on the end furthest from the end you want to
fillet.

15. Press <Enter> to repeat the Fillet  command.

16. The default fillet radius is now 0.5 so proceed directly to picking the two lines to
fillet and press <Enter>.
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17. Next we will chamfer the three remaining outer corners.  From the Curve Modeling

 tab select the Chamfer  command.

18. For the chamfer length, enter 0.5 in the command window  and
press <Enter>.

19. For the lines to chamfer, select lines marked in the illustration below.  For chamfers
it is best to select the line on the end furthest from the end you want to chamfer.

20. Currently our curves are still are one polyline.  For this next step we need to

explode the polyline.  From the Curve Modeling  tab select the

Explode curves  command.

21. Select the polyline and the right-click the mouse or press <Enter>.  The polyline is
now individual curves.
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22. Now from the Curve Modeling  tab select the Extend Curves 
command.

23. Select the change line marked below to extend it to the horizontal line.

24. Now from the Curve Modeling  tab select the Trim Curves 
command.

25. Pick the line segment to trim.  When using the Trim command, you do not need to
select the trimming curve.  Just select what curve you want trimmed.
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26. Next, delete the unneeded line.  Just select it and then press the <Del> key or select

the Cut  command icon from the Quick Access Toolbar. 

6.3 Using Visual Aids

Using Visual Aids

In this step you will learn how to draw with the use of the Visual Aids mode.  With Visual
Aids enabled, construction lines automatically appear as references geometry. This
allows for easier visual placement of new geometry.  Let's see how it works.

1. Curve creation using Visual Aids can be enabled by selecting the Visual Aids 
icon on the Status Toolbar.

While Visual Aids is toggled On, the currently active Object Snaps are referenced
visually depending on where the cursor is located on the drawing.

2. For now, enable the Origin Point Snap , End Point Snap , Mid Point Snap 

, Center Point Snap  and Quad Point Snap .

3. Also disable the Grid Snap .  Your Status Bar should look like this:
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4. Now from the Curve Modeling  tab select the Circle on Point 
 command.

5. For the circle center point move the cursor near geometry in your drawing.  You will
see Visual Aids appear (i.e., reference lines). 

6. We want to locate the center of circle at the center of the fillet located in the upper
left corner of the drawing.  Move the cursor to this area and you will see two Visual
Aids appear when the end points of the fillet are recognized.

7. For the circle diameter enter 0.25  and press <Enter>.



#2: 2D Drawing & Dimensioning 81

© 2026 Mecsoft Corporation

8. Press <Enter> to repeat the command and draw a circle at the center of the lower
left fillet.

6.4 More Drawing Tools

More Drawing Tools

In this step you will learn a few additional curve creation and curve editing commands.

1. Lets draw another circle.  From the Curve Modeling  tab select the

Circle on Point  command.

2. For the center point of the circle use the Visual Aids  to locate and select the

Mid Point  intersection of the upper and right side lines.

3. For the circle diameter enter 2.0 in the command window  and
press <Enter>.
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4. Next we will draw a polar array of points around the circle we just drew. 

Why am I drawing Points?  Because when machining Hole Making
operations in CAM such as Drill, Tap, Bore, etc., you can select

points as Control Geometry!  The hole geometry DOES NOT have to be
present in the 2D drawing or 3D model in order to drill at that location.

5. From the Curve Modeling  tab select the Polar Grid of Points 
command.

6. For the total number of points on the circumference, enter 8.

7. For the angle of the first row about the X Axis enter 0.

8. Pick the center point for the polar grid or enter the coordinate values.  We want the
points centered around the 2" circle we just drew, so set you Object Snap to Center

Point  and move the cursor over the circle until the center point is highlighted
and the select it.

9. For the polar grid radius, enter 1.250 and then press <Enter>.  The polar grid of
points will be created around the circle as shown below.
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10. For this exercise we will also add the polar array of circles.  From the Curve

Modeling  tab select the Circle on Point  command.

11. For the center point, make sure the End Point Snap  is on and then select the
end point at the 12 o-clock position.

12. For the circle radius enter 0.25 and then press <Enter>.

13. Now we will duplicate the circle by creating a polar array.  First select the circle you
just created.  
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14. Then from the Modify / Transform  tab.

15. Select the Polar Array  command.  The Polar array selected objects
dialog will display.

16. The Number of Objects field should be 1.  This represents the circle that you have
selected.

17. Under the Axis Vector, the values should be X0, Y0, Z1.
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18. Under the Rotate About section, select the Pick About Point button.  The dialog will
minimize and wait for you to select a point.

19. From the Status Bar activate the Center Point Object Snap .

20. Now move the cursor over the 2" diameter circle until the center point is displayed
and then selected it.

21. The dialog will re-appear with the XYZ coordinated entered for the Rotate About
section.  The value should be X4.5, Y1.5 and Z0.

22. For the Number of Copies field enter 7.

23. The Angle to Fill field should be 360.

24. Now pick OK to close the dialog and the array should be drawn and selected.

25. Press <Enter> to accept the array and your drawing should look like the illustration

below.  If not, select the Undo  command and go back and repeat the previous
steps.
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26. Now we will drawing a slot.  From the Curve Curve Modeling tab 

select the Arc Center, Start, Angle command.

27. In the Status Bar make sure the Grid Snap is On .

28. For the center point select the grid point shown below or enter 1,1 in the command
window and press <Enter>.

29. Following the command prompts.  It says to select the start point of the arc.  Locate
and select the start point shown below or enter 1,0.75 in the command window and
press <Enter>.

30. For the arc end point move the cursor counter-clockwise and pick the end point

shown or enter 1,0.75 in the command window  and press
<Enter>.
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31. Now we want to draw another arc, press <Enter> to repeat the command and select
or enter the center, start and end points shown below.

32. Now we want to draw a line to connect the two arcs across the top.  From the Curve

Modeling tab  select the Line command .

33. For the start point for the line, set the Object Snap to End Point  from the Status
Bar and select the start and end of the top line of the slot.

34. Press <Enter> to repeat the Line command and select the start and end of the
bottom line of the slot.  Your drawing should look like this:
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6.5 Dimensioning

Dimensioning

In this step you will learn how to place dimensions on the drawing.

1. Start by using the middle mouse wheel to zoom out to leave yourself plenty of
room to place your dimensions.  If your mouse does not have a middle wheel, select

the Zoom Out  icon from the View Toolbar.  You can also use the Pan  icon
to pan the drawing within the display window.

2. Now change the active layer.  From the Status Toolbar select the Layer Manager 
 icon.

3. From the Layer Manager go to the Active column and check the box next to
Dimensions to make it the Active Layer.

4. From the Dimension  tab, select the Vertical Dimension 
command.

5. Activate the Object Snaps required (End , Center  and Grid )

6. Select the first and second points that you wish to dimension.

7. Then select a point to locate the dimension.  refer to the illustration below:
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8. Press <Enter> to repeat the command.

9. Select the first, second and location point for the dimension as shown below:

10. Repeat the command to create three additional vertical dimensions on the left as
illustrated below:
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11. Repeat the command to create three additional vertical dimensions on the right as
illustrated below:

12. Now we will create the horizontal dimensions.  From the Dimension 

 tab select the Horizontal Dimension  command.

13. Select the first second and location points to create the lower horizontal
dimensions shown below:
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14. Repeat the command to create the upper horizontal dimensions shown below:

15. Now we will create some leader lines.  From the Dimension  tab select

the Leader Line  command.

16. The first command prompts says: "Enter the text string."  We will add the annotation
separately so you can press <Enter> to continue.

17. The next prompt says: " Pick point or enter coordinates x,y, and z" Change the

Object Snap to Near  and select a point on the lower fillet for the first point.  
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18. Then pick additional points to define the leader line and the press <Enter> or right-
click to end the command.  The points to pick are shown in the illustration below:

19. Now repeat the Leader Line command and add the leader lines shown below:

20. Now we will add the annotation text.  From the Dimension  tab select

the Annotation  command.
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21. For the text string, at the command prompt  enter 0.50 in Fillet
(2 PLCS) and press <Enter>

22. Now select the text you just created and left-click-hold to drag it into position to the

left of the leader line as shown below.  If you toggle the Grid Snap  off you can
position the text more precisely. 

23. Repeat the Annotation command to create the additional leader text shown below:

24. Save the file as Drawing_and_Dimensioning_Completed.vcp.
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Congratulations you have completed this exercise!
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#3: Model a Spanner Plate

In this exercise you will model the Spanner Plate shown below using Curve Modeling and Solid
Modeling tools.  The exercise includes the creation of Points, Lines, Fillets, Mirroring, Merging and
Extruding curves.

Model a Spanner Plate

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Set to the Top View.

2. Create Reference Points.

3. Create Inner Cutouts.

4. Trim Curves.

5. Offset, Extend & Trim Curves.

6. Fillet Curves.

7. Mirror Curves.

8. Merge Curves.

9. Extrude Curves.

7.1 Set to the Top View

Set to the Top View

Set the view to Top View. This can be done by selecting the Top View icon from the View
Toolbar or the Orient pane of the Display Ribbon Bar.
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View Toolbar

Display Ribbon Bar - Set to the Top View

7.2 Create Reference Points

Create Reference Points

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Select the Curve Modeling Ribbon Bar:

Select the Curve Modeling Ribbon Bar

3. Select Point . 

4. Place the point at the Origin by moving the mouse cursor over to origin and with a

Left Mouse Button Click or by entering 0,0 in the command bar . 

5. As you move the mouse on the viewport, the co-ordinate value at the mouse
location is displayed under the status bar.
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Create additional points by repeating the Create Point command at the following
coordinate locations.

2.5,0
5.0,0
7.0,0

The created points are as shown below.

7.3 Create Inner Cutouts

Create Inner Cutouts

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Keep the Curve Modeling Ribbon Bar displayed. 

3. Select the Circle Center, Center, On Pt icon.

The command input bar  would now prompt you to specify the
center for the circle.

Command Prompt:
Center, On Pt:: Pick center point or enter coordinates x,y and z 

4. For the center point, pick last created point or type 7,0

Command Prompt:
Center, On Pt:: Enter point on circle::[D=0.500000] 

5. Specify 1.50 for Diameter in the command bar  and press Enter.

The created circle is as shown below.
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6. Repeat the Circle command to create 2 more circles at the center points (2.5,0 and
5,0) enter a Diameter of 1.00 for each circle.

7. From the Status Bar, toggle Grid Snap off and then toggle Quad Point Snap on.

  

8. Select the Create Single Line icon.

 

9. Create a line between the top quadrants points of the smaller circles.
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10. Repeat the line for lower quadrant points.

7.4 Trim Curves

Trim Curves

The circles must be trimmed. 

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Select Trim  

3. Click on the portion of the circle you want to delete.
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4. Repeat for the circle portion on the other side. 
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7.5 Offset, Extend & Trim Curves

Offset, Extend & Trim Curves

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Keep the Curve Modeling Ribbon Bar displayed and then select the top horizontal
line.

3. Pick the Offset Curve  icon from the Edit Curves pane.
A preview line will appear, indicating the direction of offset. Point the preview line
to offset the curve outward and then type 0.75 from the keyboard and press Enter.  

For Offset Curve, your cursor points to the offset direction, so do not

move the cursor to the Command Prompt  field. 
Simply type 0.75 and press Enter to input the value.
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4. Repeat the offset for the horizontal line at the bottom, making sure to keep the
cursor and directional indicator line pointing downward.

5. Select the larger circle on the right and then pick the Offset Curve icon again. 

6. With the cursor, point the offset direction outward from the circle, type 0.50 and
press Enter.



#3: Model a Spanner Plate 103

© 2026 Mecsoft Corporation

7. To modify the offset lines so that they meet the larger circle, pick the Extend Curve

 icon from Edit Curves pane.  It is located just to the right of the Offset Curve
icon. 

8. Click one of the offset lines towards the right. The line extends to the point where it
meets the circle.
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9. Repeat the extend curve for the line at the bottom.

10. Select Trim  and trim the large circle where it meets the two extended lines.
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7.6 Fillet Curves

Fillet Curves

We will now create the left section of the spanner using the filleting and mirroring tools.
 We will start by creating the arc at the end of the spanner.

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. From the Curve Modeling Ribbon Bar, select Center, Start, Angle Pts. 

Command Prompt:
Center,Start,Angle Pts:: Pick center point or enter coordinates x,y and z 

3. For the Center, type 0,0 in the Command Prompt  and then press
Enter. 

4. For Start, type 0,1.25 in the Command Prompt  and then press
Enter. 
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5. For End, type -180 in the Command Prompt  and then press
Enter.
Your drawing should look like the following:

6. Now create a reference point located at 0,2.25 using the Point  command. 
The icon is located on the left side of the Curve Pane of the Curve Modeling Ribbon
Bar.

7.  From the Status Bar, toggle End Point Snap  On.

8. Now, select Rectangle . 

9. For the 1st corner pick the point you just created and for the other corner snap to
the End Point of the horizontal line as shown below.
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10. This rectangle is one object – one multi-segmented curve. In order to be able to edit
or modify this rectangle, it must be broken into individual lines. 

To do this, select the Explode icon.  It is located on the far right side of the Edit
Curves pane of the Curve Modeling Ribbon Bar. 

11. Select the rectangle and then right-click or press Enter.
Now each line of the rectangle is a separate object. 

12. Select Fillet .

Command Prompt:
Fillet:: Enter fillet radius [R=0.500000] 

13. For Radius enter 0.5 and press Enter. 

14. Select the 2 curves as shown below to fillet the curves.
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The filleted curve is as shown below.

15. Let's now create another arc.  Again, from the Curve Modeling Ribbon Bar, select

Center, Start, Angle Pts. 

Command Prompt:
Center,Start,Angle Pts:: Pick center point or enter coordinates x,y and z

16. For Center pick the end point on the upper right corner of the rectangle.

17. For Start pick the lower right corner of rectangle as shown below.
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18. For Angle, type in -90 and then press Enter to create an arc in the top right corner of
the rectangle.

The created Arc is shown below:

19. To clean up the corners we select Trim  again.

20. Select trimming curves to obtain the shape as shown below:
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7.7 Merge Curves

Merge Curves

Now we will merge our curves into three separate closed curves.

1. Select all the curves by using a crossing window selection:
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2. Now, go back to the Curve Modeling Ribbon Bar select the Merge Curves  icon
and then right-click or press Enter.  The curves are merged to 3 closed curves as
shown below.

7.7.1 Mirror Curves

Mirror Curves

We will now select the 4 curves that form the head of the spanner and mirror them.

1. Select the 4 curves as shown below. Hold down the Ctrl key to select multiple
objects.
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2. With the 4 curves selected, you will notice that VisualCAD's Modify mode
automatically becomes active and that the Transform Ribbon Bar becomes available.
 Refer to the menu image below:

The Transform Ribbon Bar is Activated

3. Now there are two methods to activate the Mirror command.  Select the method
that suits you best.
You can select the Transform Ribbon Bar tab and then select the Mirror icon as
shown:

The Mirror icon on the Transform Ribbon Bar

- or -

While the 4 curves are selected, you can simply Right-click and select Mirror from the
pop-up menu as shown below:
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Right-clcik Menu for Editing Objects

4. From the Mirror selected objects dialog box:

Set the Mirror Plane to XZ Plane
Leave Point (P) as Origin since the origin lies on the center line of the part.
Check Create Copy
Pick OK.

The curves are mirrored as shown below.
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7.8 Extrude Curves

Extrude Curves

Now to complete the exercise we will extrude our 3 curves to create the final Spanner 3D
model.
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1. Select all the curves by using a crossing window selection:

2. Select the 3 closed curves. 

3. Select Iso from the View Toolbar 

4. From the Solid Modeling Ribbon Bar, select Extrude. 

5. Preview curves will appear to determine the direction of extrusion. 
Set the extrusion to point in the positive Z direction by moving the cursor above the
geometry.
Then type 1.0 in the command input bar and press the <Enter> key.

Command Prompt:
Extrude:: Enter extrusion distance::[L=1.000000]
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The curves are now extruded and displayed as shown below.

6. Save the file as Spanner_Completed.vcp.

This completes this exercise. 
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#4: Model a Base Plate

In this exercise you will model something a bit more complicated, the base plate shown below. 
You will learn how to draw and model basic shapes to create this 3D model.

Model a Base Plate

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Draw the Base Plate Profile.

2. Extrude the Base Plate.

3. Model the Tube.

4. Create a New Layer.

5. Edit Geometry Properties.

8.1 Draw the Base Plate Profile

Draw the Base Plate Profile

In this exercise you will learn the following VisualCAD concepts:

1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Now select the Rectangle command.

3. For the first corner of the rectangle, select the lower left grid point location shown

below or type -3,-3 in the Command Prompt  and press <Enter>.
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4. For the second corner of the rectangle, select the upper right grid point shown

below or type 3,3 in the Command Prompt  and press <Enter>. 
This will create a rectangle 6" square.

5. To fillet the corners, select the Fillet  command from the Curve Modeling

 tab.

6. For the fillet Radius, enter 0.5 in the command prompt  and
press <Enter>.

7. Now select the first edge to fillet as shown below.  Note: When selecting curves to
fillet, it is best to select furthest away from the corner that you wish to be filleted.
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8. Now select the second edge to fillet and a 0.5 radius fillet is added to the rectangle
as shown below.

9. Now press <Enter> to repeat the Fillet command and fillet the remaining 3 corners
of the rectangle as shown below.  If you make a mistake, you can select the Undo
command located on the Quick Access toolbar and try again.
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10. Now lets add the mounting holes.  From the Curve Modeling  tab,

select the Circle on Pt command. 

11. For the center point of the first hole select the grid point shown below or enter -

2.5,2.5 in the command prompt  and press <Enter>.

12. Now for the circle radius you can select the next grid point to the right of the center
point you just selected or enter 0.5 for the diameter and press <Enter>.
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13. Repeat the Circle on Pt command and draw the other three circles in the locations
shown below.

8.2 Extrude the Base Plate

Extrude the Base Plate

In this step we will extrude our drawing to model the base plate in 3D.

1. First, window select the drawing by picking two points.  Click and hold the left
mouse button to drag a window around the drawing as shown below.  If you drag
from left to right everything completely the window is selected.  If you drag from
right to left everything that cross over the window will be selected.
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2. After your drawing is selected, go to the Mesh Modeling tab  from

the Ribbon Bar and select the Extrude command. 

3. Now move the cursor down to the Front View  and you will see that
you can drag the height of the extrusion.  Select the second grid point in the
positive Z direction or type 0.5 and press <Enter>.

You will see the extrusion display in all four viewports.  The Iso View 1 
view is shown below.

4. Save your work by selecting the Save icon from the Quick Access toolbar.
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8.3 Model the Tube

Model the Tube

In this step we will draw two concentric circles and then extrude them to model the
circular tube that sits at the base plate.

1. Select the Top View  to activate it.

2. From the View Toolbar drop down the Display menu  and select Wireframe
Display.  This will allow us to better see our next drawing.

3. Now from the Curve Modeling  tab select the Circle on Point

command again. 

4. For the center point select the grid point at 0,0 center of the drawing.

5. Now for the circle diameter you can select the grid point shown below or type in 3
and press <Enter>.  A circle 3" in diameter is drawn.
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6. Now repeat the command, this time drawing a circle with a diameter of 2.5" in
diameter.

7. Once the two concentric circles are drawn, select them both.  You can window select
them or while holding down the <Ctrl> key, just pick both of them.

8. With the two circles selected, go to the Mesh Modeling  tab and

select the Extrude  command again.

9. Now move the cursor to the Front View  and select the grid point
located at 3" in the positive Z direction as shown below.
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10. The center tube is now created and shown in each window.

11. Save your work by selecting the Save icon from the Quick Access Toolbar.
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12. Activate the Right View  by selecting anywhere on the grid.

13. From the View Toolbar, drop down the Display  menu and select Wireframe
Display.  Again, this will allow us to better see our next drawing.

14. From the Curve Modeling  tab, select the Circle on Pt 
 command again.

15. For the center point of the circle, select the grid point shown below.

16. Now for the circle diameter you can select the grid point shown below or enter 1.0
for the diameter.
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17. Now select the circle you just created, then go to the Mesh Modeling 

 tab and select the Extrude  command again.

18. For the length of the cylinder move the cursor over to the Front View 
 and select the grid point shown below.

19. Now select the cylinder and toggle the display of the Graphic Manipulator  on. 
This toggle icon is located on the Status Bar at bottom of the display.
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20. With the cylinder selected pick on the red X axis of the Graphic Manipulator to

display the input box and enter -2.25  and press <Enter> as
shown below.

The cylinder is translated to the left negative X direction by 2.25 inches so that it
passes complete through the tube on both sides.

21. You can toggle the Graphic Manipulator  off.

22. From the Mesh Modeling  tab, select the Subtract command . 
It's located in the Edit Meshes pane.  We are going to Subtract the cylinder from the
tube.

23. For the first mesh select the tube.

24. For the second mesh select the cylinder.  The hole is created in both sides of the
tube.
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8.4 Create a New Layer

Create a New Layer

In this step we will create a new layer, turn it off and the move our curves to it to hide
them from the display.

1. From the Status Toolbar, select the icon to display the Layer Manager .

2. At the top of the Layer Manager select the New Layer icon and a new layer will be
added to the list. 
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3. Now double-left click on the New Layer name and type in the names "Curves" and
press <Enter>.

4. Now to hide the Curves layer first check the box to make the Default layer the
Active layer.

5. Then uncheck the box to make the Curves layer hidden.

6. Now let's Auto Hide the Layer Manager.  Select the Auto Hide pin  icon located at
the top right of the Layer Manager and will see that the dialog disappears to the left
side of the screen.
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8.5 Edit Geometry Properties

Edit Properties of Geometry

In this final step we will select all of our reference curves and edit their properties so
that they are moved to a layer whose visibility is currently off.

1. Let's start by selecting the Properties icon  located on the Status Toolbar at the

bottom of the display (just to the left of the Layer Manager  icon).

2. You will see the Properties Manager dialog display om the left side of the display.

3. Now we will automatically select all of our curve geometry.  Go to the Modeling

Aids tab and select pick the Select by Type  icon.  This will display the
Object Selection Filters dialog.
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4. From the dialog check the box for Curves and uncheck all other boxes and then pick
OK to close the dialog.  You will see that all of the curves are highlighted for
selection.
Now go to the Properties Manager and under the Objects section drop down the
menu for Layer and select Curves.

5. Now close the Properties Manager by selecting the Auto Hide pin located at the top
right of the Properties Manager.
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6. This exercise is complete and your part now looks like this:

7. Save the file as Base_Plate_Completed.vcp.
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#5: Model a Mold Insert

In this exercise you will model something a bit more complicated, the mold insert shown below. 
It builds upon the tasks you have learned in the previous exercises.  You will draw curve profiles
and then turn them into part features.  The Graphic Manipulator is used extensively in this
exercise as well as modeling from multiple viewports.  Just go slowly and save your work often
and Undo if needed.

Model a Mold Insert

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Extrude the Body.

2. Extrude the Flange.

3. Extrude the Upper Pocket.

4. Extrude the Lower Pocket.

5. Revolve the Center Bosses.

6. Extrude the Connection Bar.

7. Extrude the Connection Wall.

8. Extrude Ejector Pin Holes.

9. Change Geometry Layer.

10. Create Section Curves.
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9.1 Extrude the Body

Extrude the Body

In this step we will model the body by creating an extrusion.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Select the Curve Modeling tab  from the top Ribbon Bar.

3. Now select the Arc Center, Start, Angle command.

4. In the Status Bar make sure the Grid Snap is On .

5. For the center point select the grid point shown below.  The status bar will track
where your cursor is located in World Coordinates.  Move the cursor until the grid
point at 1.5,0,0 is located and pick it.

6. Following the command prompts .  It says to select the start
point of the arc.  Locate and select the start point shown below.

7. For the arc end point move the cursor clockwise and pick the end point shown.  You
will see that the arc is previewed as you move the cursor.

8. Now we want to draw another arc, press <Enter> to repeat the command and select
the center, start and end points shown below.
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9. Now we want to draw a line to connect the two arcs across the top.  From the Curve

Modeling tab  select the Line command .

10. For the start point for the line select the grid point located at the top end of the arc
of the left and then for the end point of the line select the top end of the arc on the

right.  Optionally, you can set the Object Snap to End Point  from the Status Bar
and select the end points of the arcs to draw the line.

11. Press <Enter> to repeat the Line command  and draw the second line
connection the two arcs across the bottom.  Your drawing should look like the image
below.
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12. For modeling its best that you merge your profile geometry into a single curve
entity.

13. Window select the geometry (both arcs and both lines) and from the Curve

Modeling tab  select the Merge Curves  command and then
right-click the mouse to merge them.  If you pick anywhere on the geometry you
will see that one curve is now defined.

14. Now lets create the body by extruding our profile curve.  With the curve selected,

change to the Mesh Modeling tab  and select the Extrude Mesh

 command.

15. For the extrusion distance, drag the cursor down to the Front View  and
select the grid point shown below.  Its located at 2.0" below the selected curve. 

The Mesh Solid is created and shown below.
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9.2 Extrude the Flange

Extrude the Flange

Now we will extrude the flange.

1. Activate the Top View  by selection the profile curve you just created. 
You will notice that a selection list pops up because there is now more than one
entity in the same located.

Note: If the Selections menu shown below does not display, go to the Home tab in
VisualCAD and select Options.  Then under System clear the check box next to Use
Preselection Highlight.
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2. From the selection list pick Curve.  The number value to the right of the curve may
change depending on when the entity is created.

3. With the curve selected, from the Curve Modeling tab  select the

Offset Curve  command.

4. If you move the cursor you see that an offset direction is indicated.  Move the cursor
below and on the outside of the curve as shown below.

5. Most of the time in this exercise we are selecting grid points.  The distance between
each grid point is 0.25".  For the offset distance you can select the next grid point
below the curve.  

Optionally, while the offset direction is displayed you can enter 0.25

 and press <Enter> to create the offset curve shown below.

6. Now select the offset curve you just created, go to the Mesh Modeling tab

 and pick the Extrude Mesh  command again.
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7. Drag the cursor to the Front View  and pick the second grid point below
the selected curve.  The cursor indicates that the extrusion length is 0.500".

The flange is created and displayed.

8. Now lets move the flange to the bottom of the body.  To do this we will use the
Graphic Manipulator.  To toggle the Graphic Manipulator on, go to the Status Bar and

select the icon .

The Graphic Manipulator allows you to easily translate or rotate a selected entity in
or about the X, Y or Z of the World Axis.

9. Now select the flange and you will see that the Graphic Manipulator is displayed on
top of the selected entity.
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10. Pick on the blue Z Axis arrow to display the input window.

11. Enter -1.5  and press <Enter>.

The flange is moved 1.5" in the negative Z direction.

12. Now lets unite the flange with the body.  From the Mesh Modeling tab,

 select the Unite Mesh  command.

13. For the first mesh solid select the body.
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14. For the second mesh solid select the flange.  The two will be joined into one mesh
solid.

9.3 Extrude the Upper Pocket

Extrude the Upper Pocket

In this step we will create the upper pocket and subtract it from the body.

1. From the Top View  select the profile curve of the body by clicking on it
and selecting Curve from the selection list.

2. With the curve select, go to the Curve Modeling tab  and select the

Offset Curve  command.

3. Drag the offset direction to the inner side of the curve and then enter 0.05

 and press <Enter>.
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4. Now select the offset curve, go to the Mesh Modeling tab  and select

the Extrude Mesh  command.

5. Drag the cursor down to the Front View  and select the grid point at
0.750" as shown below.

6. Now to see the pocket mesh solid, from the View Toolbar  select the
Wireframe Display item from the display menu.
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7. We want to move the pocket mesh solid so make sure the Graphic Manipulator icon

is still toggled on  (it's located on the Status Bar remember?).

8. With the Front View  set to Wireframe display you can see to select the
pocket mesh solid.  Select it now and the Graphic Manipulator will display on it.

9. Select the blue Z Axis arrow and enter 0.25  and press <Enter>. 
The pocket mesh solid will move upward 0.25".

10. From the View Toolbar  drop down the display menu and select Toggle
Shading + Edges.
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11. Now lets subtract the pocket from the body.  From the Mesh Modeling tab

 select the Subtract Mesh  command.

12. For the first mesh solid select the body.  This is the solid that will be subtracted
from.  You can do this from any Viewport.  We will select it from Iso View 1

.

13. Now for the second mesh solid, select the pocket solid and it will be subtracted
from the body.

9.4 Extrude the Lower Pocket

Extrude the Lower Pocket 

In this step we will create the lower pocket mesh solid and subtract it from the body.

1. We will start in the Top View  so select anywhere in that view to activate
it.

2. Now we will create two partial arcs, each 270 degrees.  From the Curve Modeling tab

, select select the Arc Center, Start, Angle command  again.
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3. Select the center point first and then select the start point.  Both are shown below.

4. Now for the end point of the arc, drag the cursor counter clockwise until the arc
preview is at 270 degrees as shown below.

5. Now press the <Enter> key to repeat the command.  This time select the center,
start and end points shown below.

You drawing should now look like this:
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6. Now we will rotate each arc 45 degrees to position them properly.  Toggle the

Graphic Manipulator on , select the first arc.

7. This time we will use the Graphic Manipulator's rotate feature.  Select the blue Z

Axis arc, enter -45  and then press <Enter>.

The arc is rotated negative 45 degrees about the Z axis as shown.

8. Now select the second arc, pick the Z axis arc, enter 45 and press <Enter>.
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The second arc is rotate 45 degrees about the Z axis as shown.

9. To complete the second pocket profile we will fillet the two arcs.  From the Curve

Modeling tab  select the Fillet  command.

10. Enter 1.0 for the fillet radius and press <Enter>.

11. Now pick the first arc near the end shown.

And then pick the second arc near the end shown to create the 1" fillet between the
two arcs.
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12. Press <Enter> to repeat the Fillet  command.

13. Select the two arcs near their ends to create the second fillet as shown.

14. Now select the four arcs.  You can press the <Ctrl> key to select multiple entities.
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15.  Now from the Curve Modeling tab  select the Merge Curves 
command and then right-click or press <Enter> to merge them into one curve.

16. With the curve still selected go the Mesh Modeling tab  and select

the Extrude Mesh  command one again.

17. Drag the cursor down to the Front View  and select the grid point that is
1.50" below the selected curve to create the second pocket mesh solid.

18. Now once again from the Mesh Modeling tab  select the Subtract

Mesh  command and for the first solid, pick the body.

19. Now for the second solid pick the second pocket mesh solid and it will be
subtracted from the body as shown.
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9.5 Revolve the Center Bosses

Revolve the Center Bosses

In this step we will create the two center bosses by revolving a profile to create a mesh
solid, mirror it to create the second boss and then add both bosses to the body.

1. From the Front View,  select Wireframe Display from the Display

 menu on the View Toolbar.

2. From the Curve Modeling tab,  select the Polyline  command.

3. Pick the grid point shown below for the first point on in the polyline.

4. Then pick the remaining 9 grid points to complete the closed polyline.  The last grid
point is the same as the first grid point.  This forms a closed polyline.
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5. Now select the polyline, and then go to the Mesh Modeling tab  and

select the Revolve Mesh  command.  You can toggle off the Graphic

Manipulator  as we do not need it here.

6. The command prompt  says to pick the start point of the axis of
rotation.

7. Now pick the second point on the axis of rotation as shown.
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8. The revolved mesh solid is created and can be best viewed from Iso View 1

.

9. Now go to the Front View  and select the boss mesh solid we just
created.
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10. With the boss mesh solid selected you will see the Modify / Transform tab

 appear on the right end of the Ribbon Bar.  It ONLY appears when an
entity is selected.

11. From the Transform tab, select the Mirror  command to display the
Mirror selected objects dialog.

12. In this dialog, set the Mirror Plane to YZ Plane, check the box next to Create Copy,
verify that the Number of objects picked value is 1 and then pick OK. 

The mesh solid you selected:
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Has now been mirrored about the YZ plane creating a second copy as shown.

 

13. Now lets unite the two bosses with the body.  From the Mesh Modeling tab,

 select the Unite Mesh  command and then select the body.

14. Now select the second solid to unite (i.,e. the one of the two bosses we just
created.)
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15. Now press <Enter> to repeat the Unite Mesh  command and select the body
solid one again.

And then select the other boss solid to unite them.

9.6 Extrude the Connection Bar

Extrude the Connection Bar
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In this step we will create the square bar that connects the two bosses at the base of the
second pocket.

1. First activate the Right View  and then from the Display menu 
on the View Toolbar, select Wireframe Display.

2. From the Curve Modeling tab,  select the Rectangle 
command.

3. Select the grid points for the 1st and 2nd corners of the rectangle as shown.

4. Now from the Mesh Modeling tab,  select the Extrude Mesh 
command.

5. Pick the rectangle we just created and drag the cursor over to the Front View

 and pick the Grid point located 3.00" to the right as shown below.
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6. Now we want to use the Graphic Manipulator again so go to the Status Bar and make

sure it is toggled On .

7. Select Iso View 1  and right-click the mouse and drag rotate the part
until you get a good view of the Connection Bar and select it.

8. From the Graphic Manipulator pick the red X axis arrow, enter -1.5

 and then press <Enter> to see the Connector Bar move to the
left to line up on center between the two bosses as shown.
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9. Now again we will unite the Connector Bar with the Body.  From the Mesh Modeling

tab,  select the Unite Mesh  command and select the body for
the first mesh solid and the then select the Connector Bar to unite them.

9.7 Extrude the Connection Wall

Extrude the Connection Wall

In this step we will create the wall that pass between the two center bosses.
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1. Again, activate the Right View  and then from the Display  menu
on the View Toolbar, select Wireframe Display.

2. From the Curve Modeling tab,  select the Circle on Point 
command.

3. For the center point select the grid point shown below.

4. Enter 0.25  for the diameter and press <Enter>.

5. Press <Enter> again to repeat the command.  For the second circle select the grid

point shown below and then enter 0.10  for the diameter and
pres <Enter>.  We will use these two circles to locate the corners of a polyline that
defines the cross-section of the connection wall.

6. Now from the Curve Modeling tab,  select the Polyline 
command.

7. From the Status Bar toggle on the Quad Point Snap  and toggle off all of the
other object snaps.

8. We will be drawing a 4-sided closed polyline that encompasses the yellow area
shown in the image below.  For the start point of the polyline select the quad point
on the right side of the lower 0.25" diameter circle at the #1 location shown.

9. Then continue, by selecting the Quad point located at the right side of the upper
0.10" diameter circle.

10. For the next point in the polyline select the Quad point on the left side of the upper
0.10" diameter circle at the #3 location.

11. Then continue by selecting the Quad point at the #4 location.
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12. To complete the polyline select the Quad point at the #1 location where the

polyline started.  The Polyline  command will end automatically when the end
point coincides with the start point.

13. Now you can delete the two circles.  Just select them and press the <Del> key.

14. Now we will extrude the 4-sided polyline to create the Connecting Wall.  First select
the polyline we just created.
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15. Now go to the Mesh Modeling tab  and select the Extrude Mesh

 command again.

16. Drag the cursor to the Front View  and drag the length of the extrusion
to the right of the center line where the selected polyline resides.  Refer to the
image below.

17. The point we want is not on a grid point, so with the extrusion previewed (do not

select a point), go to the command prompt  and type in the
distance 2.300 and press <Enter>.  

The Connection Wall is created.
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18. Now from Iso View 1  select the Connection Wall to display the Graphic

Manipulator.  If you do not see it, make sure it is toggled on from the Status Bar 
.

19. Pick the red X Axis arrow and type in -1.15  and press <Enter>. 
The Connection Wall should move into place at the center spanning between the
two bosses as shown in the image below.

20. Now lets unite the Connection Wall with the body.  Go to the Mesh Modeling tab

 and select the Unite Mesh  command.

21. For the first mesh solid, select the body.
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Then select the Connection Wall to unite it with the body.

9.8 Extrude Ejector Pin Holes

Extrude the Ejector Pin Holes

In mold design, ejector pins are used to eject the molded part from the cavity side of the
mold.  As the mold press opens, the ejector pins slide and protrude through the cavity
forcing the plastic part out of the mold where it falls into a catch bin.  The ejector pin
holes pass complete through the insert.

1. Activate the Top View  and then go to the Curve Modeling tab

 and select the Circle on Point  command.

2. We will draw a total of 4 holes.  Two will be 0.3125" in diameter (located at #1 and
#2) and two will be 0.3750" diameter (located at #3 and #4).
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3. Select the grid point at the #1 location and then enter 0.3125 in the command

prompt  and then press <Enter>.

4. Press <Enter> to repeat the command.

5. Select the grid point at the #2 location and press <Enter> again to accept the new
default diameter.

6. Now press <Enter> to repeat the command, select the grid point at the #4 location

and then enter 0.375 in the command prompt  and then <Enter>.

7. Now press <Enter> again, select the grid point at the #4 location and press <Enter> to
accept the new default diameter.  The 4 circles are drawn.

8. Now with the <Ctrl> key pressed, select the 4 holes, go to the Mesh Modeling tab

 and select the Extrude Mesh  command.

9. Now move the cursor down to the Front View  and drag the extrude
length down past the bottom of the body and pick the grid pint located at 2.500"
below the part.

The 4 mesh solids are created:
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10. Now let's move the 4 ejector pin holes upward to pass through the body
completely.
Window select right to left so that the cross-hatched window passes through all 4
ejector pin mesh solids.

11. If the Graphic Manipulator does not display, pick the icon on the Status Bar to toggle

it on .

12. Select the Blue Z arrow and in the input window enter 0.25  and
press the <Enter> key twice.  The first accepts the value and the second to move the
mesh solids.

Activate the Right View  and we see the ejector pin mesh solids.
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13. Now to subtract the ejector pin mesh solids from the body to create the ejector pin

holes go to the Mesh Modeling tab  and select the Subtract Mesh

 command.

14. Select the body as the first mesh solid.

15. Then select the 0.3125" ejector pin mesh solid on the right to subtract it from the
body.

16. Press the <Enter> key to repeat the Subtract Mesh  command and select the
body again as the first mesh solid.

17. Then select the 0.3125" ejector pin mesh solid on the left to subtract it from the
body.

18. Press the <Enter> key to repeat the Subtract Mesh  command and this time

to subtract the 0.3750" ejector pins move to the Front View .
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19. Select the body again as the first mesh solid.

20. This time select the 0.3750" ejector pin mesh solid on the right to subtract it from
the body.

21. Press the <Enter> key again to repeat the command and then select the body mesh
solid.

22. Now select the remaining 0.3750" ejector pin mesh solid to subtract it from the
body.

You will now see that the 4 ejector pin hole locations pass completely through the
mold insert as shown in the images below:
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9.9 Change Geometry Layer

Change Geometry Layer

We have a lot of curves displaying on the part.  Let's clean them up.

1. Display the Layer Manager.  You can pick the Layer Manager icon  located on the
Status Bar or select the Layers flay-out tab located on the left side of the drawing
window.  If you recall we unpinned the Layer Manager allowing it to collapse to the
side of the screen.

2. From the Layer Manager select the Add Layer icon  to add a new layer.

3. Now lets rename the new layer to Curves.  First double-left-click in the Name field
to activate it, and enter Curves as the new layer name.

4. Next lets make the Default layer the Active Layer by checking the box in the Active
column for the layer Default.  The Default layer is now the active layer.  Let's also
uncheck the box in the visible column for the Curves layer.  Now any geometry
placed on the Curves layer will be hidden from view.  Your Layer Manager should
look like the one shown below.
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5. Now VisualCAD has a quick way of selecting entities by type.  Go to the Modeling

Aids  tab and select the By Type  icon.  This command
displays the Object Selection Filters dialog that allows you to check mark the
entities that you want to select.  That dialog is shown below:

6. Place a check mark in the box for each of the following entity types: Point,
Line,Polyline, Arc, Circle, and Curve.
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7. Now pick the OK button.  You will see that all of the reference curves we created in
this exercise are highlighted for selection.

8. With the entitles selected, select the Properties  icon from the Status Bar.  Its

located just to the left of the Layer Manager  icon.

9. The Properties Manager will display on the left side of the screen similar to the
Layer Manager.

10. At the top of the Properties Manager select the Edit  icon.  This will display
additional fields that you can edit.

11. We want to change the layer of the curves so drop down the layer menu by

selecting the menu indicator  on the right side in the Layer row and select the
new layer named Curves that we recently created and hidden.
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12. Now when you click anywhere in the drawing window you will see that all of the
curves have been moved to the Curves layer and are not hidden from view.

9.10 Create Section Curves

Create Section Curves

Congratulations, our part is now nearly complete!  However, we do want to create cross-
section curves that will aid you when it comes time to create a detail drawing of the part.

Section curves are drawn parallel to the active Viewport.  So the first step is to select the
view that you want the section to be parallel to.  We want to create three sections, one
through the center parallel to the Front View and another two through each boss parallel
to the Right View.

1. First lets again create a new layer and make it the active layer so that the section
curves will be assigned to that layer automatically when they are created.

2. Display the Layer Manager  one again.

3. Create a new layer and name it Sections and also make it the active layer.  The Layer
Manager should look like this:
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4. Now go to the Curve Modeling tab  and select the Section Curve 
command.  The Create section curves dialog will display.

5. First select anywhere in the Front View  to activate it.

6. Now if you move the slider in the dialog you will see the section curves move along
the part.

7. We want the location of the section to be precise so lets pick the Button that says
"Pick point on model".

8. Now from the Top View  pick the grid point location at the center of one
of the two bosses as shown below.  Notice that the Top View IS NOT ACTIVE.  We

want the Front View  to stay active while the section point is picked.
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9. When you pick the point at the center of the boss, you will see the section curves
display on the part.  They pass through the center parallel to the Front View just like
we want.

10. Now press the <Enter> key to repeat the section command and then activate the

Right View .

11. From the Create section curves dialog select the button again that says "Pick point
on model".

12. Now from the Top View  pick the grid point location at the center of the
boss on the right side.  Notice that the Top View IS NOT ACTIVE.  We want the Right

View  to stay active while the section point is picked.

13. When you pick the point at the center of the boss, you will see the section curves
display on the part.  They pass through the center of the boss parallel to the Right
View just like we want.
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Congratulations!!  You modeled your Very first mold insert using VisualCAD! 

14. Save the file as Insert_Completed.vcp.
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#6: Model a Connector Block

In this exercise you will model the Connector Block shown below.  It too builds upon the tasks you
have learned in the previous exercises.  You will draw curve profiles and then turn them into part
features.  The Graphic Manipulator is again used extensively in this exercise as well as modeling
from multiple viewports.  Again, just go slowly and save your work often and Undo if needed.

Model a Connector Block

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Model the Main Body.

2. Model the Front Access.

3. Model the Top Access.

4. Model the Mounting Holes.

5. Modify the Top Access.

6. Create Section Curves.

10.1 Model the Body

Model the Main Body
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1. Select the Curve Modeling tab  from the top Ribbon Bar.

2. Now select the Rectangle command.

3. Turn on Grid snap  and turn off all other object Snaps.  Object Snap toggles are
located on the Status Toolbar at the bottom of the display.

4. For the first corner of the rectangle, select the lower left grid point location shown

below or type -1.5, 0, -1.5 in the Command Prompt  and press
<Enter>.

5. For the second corner of the rectangle, select the upper right grid point shown

above or type 3,3 in the Command Prompt  and press <Enter>. 
This will create a rectangle 3" square.

6. Now select the rectangle you just drew and then from the  tab select

the Extrude Mesh  command.

7. Now drag the cursor over to the  and select the grid point at 4.5 or just

enter 4.5 in the command prompt  and press <Enter>.
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Your part should look like this in Iso View 1:

10.2 Model the Front Access

Model the Front Access

1. Activate the .

2. From the tab  select the Rounded Rectangle  command.

3. For the first corner of the rectangle, select the lower left grid point location shown

below or type 1.25,1.25,0 in the Command Prompt  and press
<Enter>.
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4. For the second corner of the rectangle, select the lower left grid point location

shown below or type 1.25,1.25,0 in the Command Prompt  and
press <Enter>.

5. Now for the corner radius select the Grid point shown below or enter 0.5 in the

Command Window  and press <Enter>.

6. Now select the rounded rectangle you just created and from the  tab,

select the Extrude Mesh  command.

7. Move the cursor over to the  and select the Extrude Length at the 1.000

Grid point or enter 1 in the command window  and press
<Enter>.
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The extruded profile is shown below.

8. Now we will move the extrusion so that it intersects the body.  Activate the Graphic

Manipulator  from the Status Bar.

9. Select the extrusion mesh solid to display the Graphic Manipulator .

10. Pick the Green Y axis of the Graphic Manipulator  and enter 0.25 in the input
field and press <Enter>.  The extrusion will move in the Y direction the amount
specified.



#6: Model a Connector Block 181

© 2026 Mecsoft Corporation

11. Press <Enter> again to accept the move.

12. Now activate the  window and from the  tab select the

Subtract Mesh  command.

13. For the first mesh solid select the Body.

14. For the second mesh solid select the extrusion.  The extrusion will be subtracted
from the Body as shown below.

15. Now activate the Top View.

16. Select the View  menu from the View Toolbar and then select Ghosted
Display. Note: The View Toolbar will only display in the active viewport.
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17. Now from the Curve Modeling  tab select the Polyline  command.

18. You will select the grid points shown below to define a closed polyline.  The first
grid point is the same as the last grid point.

In Iso View 1 the closed curve polyline looks like this:
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19. Now select the closed curve polyline you just created and from the 

tab select the Revolve Mesh  command.

20. The command line  prompts you to "Pick start point if axis of
revolution or enter coordinates x,y and z".  Pick the grid points shown below for the
start and end points of the axis of revolution.

The Revolve mesh solid is created.

21. Now you want to subtract it from the Body.  From the  tab select the

Subtract Mesh  command.

22. For the first mesh solid select the Body.

23. For the second mesh solid select the Revolve. 
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The Body is updated and should look like the image below.

10.3 Model the Top Access

Model the Top Access
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1. Activate the .

2. Select the View  menu from the View Toolbar and then select Wireframe
Display. Note: The View Toolbar will only display in the active viewport.

From the  tab select the Rounder Rectangle  command.

3. For the first corner of the rectangle, select the upper right grid point location shown

below or type 1.25,1.25,0 in the Command Prompt  and press
<Enter>.

4. For the second corner of the rectangle, select the lower left grid point location

shown below or type 1.25,1.5,0 in the Command Prompt  and
press <Enter>.

5. Now for the corner radius select the grid point shown below or enter 0.5 in the

Command Window  and press <Enter>.
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6. Now select the rounded rectangle you just created and from the  tab,

select the Extrude Mesh  command.

7. Move the cursor down to the Front View and select the Extrude Length at the 2.000

Grid point or enter 0,0,2 in the command window  and press
<Enter>.

8. Now activate Iso View 1 and from the  tab select the Subtract Mesh

 command.

9. For the first mesh solid select the Body.
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10. For the second mesh solid select the extrusion.  The extrusion will be subtracted
from the Body as shown below.

11. The top access has an additional pocket near the front of the body that needs to be
modeled.

12. Activate the  again.

13. From the  tab select the Rounded Rectangle  command.

14. For the first corner of the rectangle, select the lower left grid point location shown

below or type -1,0.5,0 in the Command Prompt  and press
<Enter>.
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15. For the second corner of the rectangle, select the upper right grid point location

shown above or type 1,2.75,0 in the Command Prompt  and
press <Enter>.

16. Now for the corner radius select the grid point shown below or enter 0.5 in the

Command Window  and press <Enter>.

17. Now select the rounded rectangle you just created and from the  tab,

select the Extrude Mesh  command.

18. Move the cursor down to the  and select the Extrude Length at the

2.000 Grid point or enter 0,0,2 in the command window  and
press <Enter>.
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19. Now from , select the extrusion you just created to display the Graphic

Manipulator .

20. Click on the Blue Z Axis arrow and enter 1.25  to translate the
extrusion upward as shown in the illustration below.
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21. From the  tab select the Subtract Mesh  command.

22. For the first mesh solid select the Body.

23. For the second mesh solid select the extrusion you just created.

10.4 Model the Mounting Holes

Model the Mounting Holes

In this step we will model the tap drill mounting holes in the front and top access.  Note:
For machining purposes only a Point is required to perform a hole making operation.  We
are only modeling the holes here for learning purposes.

1. Activate the .

2. To locate the center of the first hole you will draw two lines on the grid.  From the

Curve Modeling  tab select the Line  command.
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3. Draw the two lines shown below.  The first starts at the center and ends at the top
left corner.  The second passes diagonally across two grid points bisection the first
line at 90 degrees.

4. Now from the Curve Modeling  tab select the Circle  command.

5. For the circle center, activate the Intersect Object Snap  from the Status Bar and
then move the cursor over the intersection of the two lines until you see Int display
next to the cursor and then select the intersection point.

6. For the circle diameter enter 0.1959 in the Command Window 
 and press <Enter>.  This is the #7 drill diameter for a 1/4-20 tap.

7. Now you need 4 of these holes.  Let's use the mirror command to create the other
three.  First select the circle you just created, then go to the Modify / Transform

 tab and select the  command.
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Note that the Modify / Transfer tab ONLY appears when an entity is selected!

8. From the Mirror selected objects dialog, the Number of selected objects should be
1, The Mirror Plane should be YZ Plane and box next to Create Copy should be
checked. 

9. Pick OK from the dialog and the circle will be mirrored and both circles should be

selected automatically.  If not, select both of the circles and pick the 
command again.
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10. This time from the Mirror selected objects dialog, the Number of selected objects
should be 2, The Mirror Plane should be XY Plane and box next to Create Copy
should be checked.

Note: You do not have to select the geometry first, as you can see this dialog has a
Pick Objects button.

11. Now with all 4 circles drawn, all 4 should be selected automatically.  If not select
them now.

12. Now go to the  tab and select the Extrude Mesh  command.

13. For the extrude length move the cursor to the  and select the grid point
at 0.500" in the positive Z direction or simple enter 0.5 in the command window

 and press <Enter>.
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14. Now let's subtract the extrusions from the body to create the holes.  Go to

 and from the  tab select the Subtract Mesh 
command.

15. For the first mesh solid select the body.

16. For the second mesh solid select one of the extrusions to subtract it.

17. Press the <Enter> key to repeat the command.  This time select the body and then
the second extrusion.

18. Repeat the command two more time until all 4 extrusions are subtracted from the
body as shown below. 
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19. Now we have 2 additional holes of the same diameter located in the top access. 

Activate the .

20. Let's change the display mode for the Top View.  Select the Display menu from the
View Toolbar in the Top View and select Toggle Shaded + Edges.

21. To locate the first hole, go to the Curve Modeling  tab and select the

Line  command.

22. Pick the two grid points shown below for the start and end points of the line.  The
line should bi-sect the two grid boxes from left to right as shown below.

23. Now from the Curve Modeling  tab select the Circle  command.
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24. From the Stats Bar activate the Mid Point Object Snap  and deactivate all of the
others.

25. For the center point of the circle select the mid point of the line you just created
shown in the illustration above.

26. For the circle diameter enter 0.1959 in the Command Window 
 and press <Enter>.

27. Now select the circle you just created and go to the  tab and select the

Mirror  command.

28. From the Mirror select objects dialog the Number of selected objects should be 1,
the Mirror Plane should be YZ Plane and the Create Copy box should be checked.

29. Now pick OK to mirror the circle.

30. Both circles should now be selected.  If not select them both now.
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31. With the circles select go to the  tab and select the Extrude Mesh

 command.

32. From the Status Bar activate the Grid Object Snap  and deactivate the others.

33. Move the cursor down to the  and select the grid point to set the
extrusion length to 0.500" in the negative Z direction or simply enter 0.5 in the

command window  and press <Enter>.

34. Now select the two extrusions and go to the .  Make sure the Graphic

Manipulator  is toggled On.

35. From the Graphic Manipulator, pick the Blue Z Axis arrow and then enter 0.25 in the
input window and press <Enter>.  The extrusions will translate up in the Z axis 0.25".
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36. Now subtract them from the body.  From the Curve Modeling  tab

select the Subtract Mesh  command.

37. For the first mesh solid select the body.  For the second mesh solid select one of the
extrusions.

38. Press <Enter> to repeat the command and subtract the second extrusion from the
body.
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10.5 Modify the Top Access

Modify the Top Access

In this step we need to make a few modifications to the top access.  The first is an
extruded cut at the back of the access.  The second is a revolved cut.

1. Activate the .

2. From the  tab select the Rounded Rectangle  command.

3. For the first and second corners of the rectangle select the grid points shown below.

4. For the corner radius, enter 0.125 in the command window  and
press <Enter>.

5. Now select the rectangle and from the  tab select the Extrude Mesh

  command.

6. Move to the  and drag the extrude length to 1.750".
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7. Now go to the  tab and select the Subtract Mesh  command
again.

8. For the first mesh solid select the body.  For the second mesh solid select the
extrusion.

9. For the second modification, got to the  and from the  tab

select the Rectangle  command.

10. Select the two corner grid points shown below.

11. Now we need to fillet one of the corners.  From the  tab select the

Fillet Curve  command.

12. In the command prompt  enter 0.125 for the fillet radius and
press <Enter>.
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13. Now select the top and left side of the rectangle to fillet the upper left corner as
shown below.

14. We need to revolve this, so select the closed rectangular profile, go to the

 tab and select the Revolve Mesh  command.

15. For the axis of revolution, select the two grid points shown below.

16. Now subtract the revolve from the body.  From the  tab select the

Subtract Mesh  command.

17. For the first mesh solid select the body and for the second select the revolve.
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10.6 Create Section Curves

Create Section Curves

Your almost done!!  In this step we want to create some section curves in the Top and
Right side views.  The section will appear on the XY Plane (for the Top view) and on the

ZY Plane for the .

1. First lets move all of our curves onto a separate layer and hide them.  From the

 tab, select the  command.  This icon is located on the

Selection pane of the  tab.

2. From the Object selection filters dialog, check the boxes next to Point, Line,
Polyline, Arc, Circle and Curve and then pick OK.  All of the curve related entities
will now be selected.
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3. From the Status Bar select the Properties icon  to display the Properties
Manager.
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4. This dialogs reports that a total of 17 entitles are selected.  In the Objects section
drop down the menu for Layer and select Curves from the list of layers.  

5. Now from the Status Bar select the Layer Manager icon .

6. From the Layer Manager, under the Active column, check the box to make the layer
named Sections the active layer.

7. You can close the Properties and Layer managers by allowing them to auto-hide or
pick the "X" icon to close them.

8. Now we're ready to create the section curves.  First activate the . 
Sections are generated for the currently active view.

9. Go to the  tab and select the Section Curves  command.  This will
display the Create section curves dialog.
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10. If you move the slider you will see a highlight of the section display in all views.

11. Now from the dialog select the Pick point on model button.  The dialog minimizes
allowing you to select a point.  From the Front View, select the XY origin grid point
to locate the section.

12. The dialog reappears and you can pick OK to close it.

13. Now activate the .

14. Go to the  tab and select the  command again.

15. From the Create section curves dialog, select the Pick button and then select the

same grid point, 0,0,0 origin in the .

16. You will now notice that section curves were created in both the XY Plane and the YZ
 Plane.
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Congratulations!!!  You completed the exercise!!

17. Save the file as Connector_Block_Completed.vcp.
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#7: Model a Daisy Decor

In this fun exercise you will use solid (or mesh) spheres, non-uniform scaling, polar arrays,
sectioning and offsetting to produce this simplistic decorative design.  The offset curves and
rectangle are used during machining as containment and stock definition.

Model a Daisy Decor    

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Create new Layers.

2. Model & Scale the Body.

3. Model & Scale the Pedal.

4. Ghosted Display Mode.

5. Polar Array the Pedal.

6. Additional Spheres Accents.

7. Create & Trim Section Curves.

8. Create Offset Curves.

9. Create the Stock Boundary.

11.1 Create new Layers

Create new Layers

In this step you will use the Layer Manager to create some new layers and then set the
active layer.

1. Display the Layer Manager.  You can pick the Layer Manager icon  located on the
Status Bar.

2. From the Layer Manager select the Add Layer icon  to add a new layer.
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3. Now lets rename the new layer to Curves.  First double-left-click in the Name field
to activate it, and enter Curves as the new layer name.

4. Repeat the procedure to create a new layer, this time named Sections.

5. Now repeat the procedure again, this time named Stock.

6. Now let's change the color of a couple of the new layers.  In the Color field left-click
on the color box for the layer named Curves.  This will display the Colors dialog.

7. Accept the default color Black and then pick OK to close the dialog.
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8. If the Layer Manager keeps Auto-Hiding to the left side of the display, select the
Auto Hide pin icon at the top of the Layer Manager.  You can also see that the layer
named Curves was changed to color black.

9. Now let's change the color of another layer.  In the Color field left-click on the color
box for the layer named Stock.  Again, this will display the Colors dialog.

10. This time select the Blue color and then pick OK to close the dialog.  You can use
different color if you wish.  If you have Auto Hide pinned, the Layer Manager will
stay displayed.
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11. This time let's set the Active Layer.  In the Active column, check the box for the layer
named Default. and then unpin the Layer Manager to close it.

11.2 Model & Scale the Body

Model & Scale the Body

In this step you will model the center body using a solid sphere and non-uniform scaling.
 Note: You can replace the Solid commands with Mesh commands if desired.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Select the Solid Modeling  tab  from the top Ribbon Bar.
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3. Now select the Sphere  command.

4. In the Status Bar make sure the Grid Snap is On .

5. For the center point select the grid point at (0,0,0) or just enter the coordinates 0,0,0

in command input bar .

6. For the sphere radius, enter 3,0,0  or select the corresponding
grid point and press <Enter>.

7. Select the solid sphere you just created.

8. You see the Modify / Transform tab  appear on the right end of the
Ribbon Bar.  It ONLY appears when an entity is selected.  Select the Transform tab.
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9. Select the Scale  command.

10. From the Scale Selected Objects dialog, select the Non-Uniform Scaling option.

11. Set the X Length to 6, Y Length to 6 and the Z Length to 2.  

12. Pick OK and the sphere is scaled as shown below.

13. Now press <Enter> to accept the modification.

14. Let's move the scaled sphere up to the origin.  First make sure the Graphic

Manipulator is On.  The icon is located on the Status Bar .

15. Now select the sphere.

16. Select the Blue Z arrow to display the input field, enter 2.0 and press <Enter>.  The
sphere will move up in the positive Z Axis to the 0,0,0 origin as shown below.
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17. Press <Enter> again to accept the move. 

11.3 Model & Scale the Pedal

Model & Scale the outer Pedal

In this step you will model and scale one of the outer pedals, again using a solid sphere
and non-uniform scaling.  Note: You can replace the Solid commands with Mesh
commands if desired.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Form the Solid Modeling  tab select the Sphere  command.

3. In the Status Bar make sure the Grid Snap is On .

4. For the center point select the grid point at (0,6,0) or just enter the coordinates 0,6,0

in command input bar  and press <Enter>.
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5. For the sphere radius, enter 4.5 in the command input window 
 and press <Enter> or select the grid point located at 0,1.5,0.

Here is what you part should look like from the Front View:

6. From Iso View 1,  select the solid sphere you just created.
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7. Select the Transform  tab from the ribbon bar.

8. Select the Scale  command.

9. From the Scale Selected Objects dialog, select the Non-Uniform Scaling option.

10. Set the X Length to 2, Y Length to 9 and the Z Length to 2.  

11. Pick OK and the sphere is scaled as shown below.

12. Now press the <Enter> key to accept the modification.

13. Let's move the scaled sphere into position along the Y Axis.  First make sure the

Graphic Manipulator  is On.  The icon is located on the Status Bar.

14. From the Front View , select the Red X arrow to display the input field,
enter 3.5 and press <Enter>.  
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15. Press <Enter> again to confirm the move and the sphere will move up to the Z 0
location as shown below.

16. Now select the sphere again.

17. Select the Blue Z arrow to display the input field, enter 3.5  and
press <Enter>.  

18. Press <Enter> again to confirm the move and the sphere will move to the X 0

location.  If you activate the Right View  your part should look like the
image below.

11.4 Ghosted Display Mode

Change the Top View to Ghosted Display

For spheres drawn from the top view, it is best viewed using the ghosted display.

1. Activate the Top View  tab by selecting anywhere in the viewport.
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2. Select the View  menu from the View Toolbar and then select Ghosted
Display. Note: The View Toolbar will only display in the active viewport.

The display should now look like this:

11.5 Polar Array the Pedal

Create the Polar Array

In this step you will create a polar array of the pedal sphere we just created.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Select the solid sphere pedal you just created in the previous step.
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3. Select the Transform  tab from the ribbon bar.

4. Select the Polar Array  command.  The Polar array selected objects
dialog will display.



#7: Model a Daisy Decor 219

© 2026 Mecsoft Corporation

5. In the Number of Objects field, enter 11.

6. The remaining options in the dialog should use the default values shown in the
dialog above.

7. Pick OK from the dialog to create and preview the polar array.
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8. Press <Enter> to accept the polar array.  Your drawing should look like the images

below.  If not, select the Undo  command and go back and repeat the
previous steps.

11.6 Additional Spheres

Create the 4 additional Spheres

In this step you will create the four spheres located in the outer corners of the design. 
Note: You can replace the Solid commands with Mesh commands if desired.

1. Activate the Top View  tab by selecting anywhere in the viewport.

2. Form the Solid Modeling  tab select the Sphere  command.
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3. In the Status Bar make sure the Grid Snap is On .

4. For the center point select the grid point at (-8,-8,0) or just enter the coordinates -

8,-8,0 in command input bar  and press <Enter>.

5. For the sphere radius, enter 1.0 in the command input bar  and
press <Enter> or select the grid point located at -8,-8,0 shown below.

6. Press <Enter> to repeat the Solid Sphere  command.

7. Create the three additional spheres located at the coordinates shown in the
illustration below.

Your drawing should look like this:
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11.7 Create & Trim Section Curves

Create Section Curves

In this step we will create section curves that lie on the XY plane.  Section curves are
useful for creating offset boundaries which in turn can be used for toolpath containment.

1. Open the Layer Manager  and set the Active Layer to Sections.  Refer to the
previous steps for displaying and using the Layer Manager.

2. Section curve are created in the plane of the active layer.  We want the section

curves to be generated on the XY plane so activate the Top View  tab by
selecting anywhere in the viewport.

3. Form the Curve Modeling  tab select the Section Curve 
 command.  The Create section curves dialog will display.
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4. If you move the slider you will see dynamically where the section curves lie.  In this

case, with the Top View  active, moving the slider will display section
curves dynamically in the XY plane and in the Z Axis.

5. We want to precisely locate the section plane so select the Pick point on model
button from the dialog.

6. Then in the Front View  pick the Z 0 grid point or simply enter 0,0,0 in

the command input bar  and press <Enter>.  The section curves
will be created and displayed in all four viewports.
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7. Open the Layer Manager and set the Active Layer to Sections.  Refer to the previous

steps for displaying and using the Layer Manager .

In the following steps we will trim our section curves and merge them.

8. From the Top View , scroll to zoom in on the center where the section
curves from the body and the pedals overlap each other.

9. From the Curve Modeling  tab, select the Trim  command.

10. Pick on the curve where you want it to be trimmed away.
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11. Press the <Enter> to repeat the Trim  command and then pick another
location to trim.

12. Repeat this procedure until all of the curves are trimmed as shown below.

13. Now scroll to zoom out to see all of the curves.
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14. Press <Ctrl+A> to select all of the curves.

15. Now from the Curve Modeling  tab select the Merge Curves 
 command.  This will merge all of the curves into one curve. This makes it easier to
work with.  Only curves that are joined end to end will be merged.  Separate curves
such as those created from the section of the outer spheres will remain separate
curves.

11.8 Create Offset Curves

Create Offset Curves

1. In the following steps you will create Offset curves from your Section Curves . 
Creating offset curves will also aid you during machining.  For example, if you do not
want to rough the entire stock, you can use section, offset or any other curve
boundaries to limit/contain your toolpaths.
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2. Open the Layer Manager  and set the Active Layer to Curves and then make all
other layers hidden.  Refer to the previous steps for displaying and using the Layer
Manager.

3. Now, select the main section curve, then go to the Curve Modeling 

 tab and select the Offset  command.

4. From the Top View  move the cursor towards the outside of the curve so
that you see the offset direction indicator point toward the outside.  DO NOT pick a
point!

5. Now with the curve offset direction displayed enter 0.5 in the command input bar

 and press the <Enter> key.  The curve will be offset toward the
outside by 0.5 inches.
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6. Press the <Enter> key to repeat the Offset  command.  This time select the
section curves from one of the outer spheres, drag the cursor to indicate the offset
direction and press <Enter> again.  The offset value will default to the last value
entered.

7. Repeat the  command to create offset curves for the other 3 remaining
section curves.

11.9 Create the Stock Boundary

Create the Stock Boundary Rectangle

In this step you will create a 24" x 24" rectangle around the part.  This can be used later
during machining to help define the stock dimensions.



#7: Model a Daisy Decor 229

© 2026 Mecsoft Corporation

1. Open the Layer Manager  and set the Active Layer to Stock.  Refer to the
previous steps for displaying and using the Layer Manager.

2. Activate the Top View  tab by selecting anywhere in the viewport.

3. Form the Curve Modeling  tab select the Rectangle 
 command.

4. For the first corner of the rectangle, you can select the grid point shown below or

enter -12,-12,0 in the command input bar  and press <Enter>.

5. For the second corner of the rectangle, you can select the grid point shown below or

enter 12,12,0 in the command input bar  and press <Enter>.

6. Save the file as Daisy_Decor_Completed.vcp.

Congratulations, you have completed this exercise!  
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#8: Using Construction Planes

In this exercise you will learn how to use Construction Planes (C-Planes) to navigate and add
features and text to your 3D models.  C-Planes are also critical in learning how to orient imported
parts for machining.  Thus learning how to orient C-Planes and how to orient parts with the use of
C-planes is critical knowledge for all VisualCAD users.

Using Construction Planes    

What you will learn:

In this exercise you will perform the following VisualCAD tasks:

1. Orient the C-Plane.

2. Draw on a Face.

3. Other C-Plane Options.

4. Orient the Part.

12.1 Orient the C-Plane

Orient the C-Plane

In this step we'll show you how to orient the Construction Plane (C-Plane).

1. First if you have completed and save the part model from Exercise #5 Connector
Block, open that part now.  It is shown below:
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Connector Block

2. Now select the Modeling Aids tab.  On the very right end of the ribbon bar you will
find the C-Plane pane.

3. From the Modeling Aids  tab select the C-Plane to 3D Face 
command.

4. The command prompt says: "Pick a flat area".  Select the right side face of the part
and you will see that the C-Plane snaps to that face.

If the Grid is not visible, select Hid / Show Grid from the View Toolbar.

It is best to have the Construction Plane Grid visible.  This allows
you to better keep track of where the C-Plane is located and

oriented.

5. You can now see that the C-Plane and the Grid is alined with the right side flat face
of the part.  You will notice that the C-Plane origin is position at the point on the flat
face you selected.
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6. You can now draw on the C-Plane (see Text on a Part Face for more information). 

From the Curve Modeling  tab select the  Circle on Point
command.

7. For the center point, toggle on the Grid Object Snap  and select the origin point
or simply enter 0,0 in the command window and press <Enter>.

8. Now select a point on the diameter of the circle.
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9. You can also move the C-Plane origin.  From the Modeling Aids  tab

select the C-Plane Origin  command.

10. The command prompt says: "Pick origin point or enter coordinates x,y and Z"  Enable

the End Point Snap  from the Status Toolbar and then select the bottom right
end point of the face.  

You will see that the C-Plane origin and the Grid is moved to this point.

11. If you need the X Axis of the C-Plane aligned horizontally across the bottom of the

part you can select the Rotate C-Plane about Axis  command.  It is also

located on the Modeling Aids  tab.
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12. The command prompt says: "Enter axis to rotate about and angle to rotate by (eg:
X,45)"  We want to rotate the Z Axis 90 degrees so enter Z,90 in the command

window  and press <Enter>.

13. Now what if you want the view orientation aligned with the C-Plane?

14. Just right-click anywhere in the view to display the View pop-up menu and select
the Align to C-Plane command.  This menu contains many Viewport related
commands.
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15. With the C-Plane aligned with the active Viewport pay close attention to where the
origin of the C-Plane is:

16. Now you may want to come back to the C-Plane later so let's save it.  From the

Modeling Aids  tab select the Save C-Plane  command.

17. In the C-Plane Name dialog enter a unique name for the active C-Plane and then
pick OK.

18. The active C-Plane is now saved with the part file.

19. Now let's change the C-Plane back to the default top view.  From the Modeling Aids

 tab select the View  menu and select Top View.
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20. Here is an easier way to align the C-Plane to the face AND align the XY Axis of the C-

Plane at the same time.  From the Modeling Aids  tab select the C-

Plane by 3 Points  command.

21. The first point selected will be the origin, so make sure the End Point Snap  is
toggled on.  

22. Then select the bottom left corner end point of the right side face of the part.  Note:
Do Not pick until you see the "End" indicated at the cursor location.

23. For the X Axis point select the end point at the back end of the part on the right side
face.
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24. For the Y Axis point select the end point at the top of the part on the right side face.

12.2 Text on a Part Face

Drawing on a Face

In the last step (see Orient the C-Plane) we discussed different ways to orient the C-
Plane.  In this step we'll show you how to draw on a selected part face.  This will come in
handy if you want to identify your 3D parts or for modifying them.

1. First if you have completed and save the part model from Exercise #5 Connector
Block, open that part now.  It is shown below:
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Connector Block

2. Now select the Modeling Aids  tab.  On the very right end of the ribbon
bar you will find the C-Plane pane.

3. From the Modeling Aids  tab select the C-Plane by 3 Points 
command.

4. The first point selected will be the origin, so make sure the End Point Snap  is
toggled on.  

5. Then select the bottom left corner end point of the right side face of the part.  Note:
Do Not pick until you see the "End" indicated at the cursor location.
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6. For the X Axis point select the end point at the back end of the part on the right side
face.

7. For the Y Axis point select the end point at the top of the part on the right side face.
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8. Now right-click anywhere in the view to display the Viewpoint pop-up menu and
select the Align to C-Plane command.  This menu contains the Viewport related
commands.
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9. If you want to simply label your part you can add dimension text that will lie on the
C-Plane.  See Drawing & Dimensioning for that exercise.

10. In this exercise we will create text curves that you can engrave with the 2-1/2

Engraving toolpath strategy, go to the Curve Modeling  tab and select

the Create Text  command.

11. This will display the Text to Create dialog.

12. For engraving text you may want to use a single stroke font.  From the Font drop-
down menu select the text font named MecSoft_Font-1.
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If you do not see the MecSoft Font, close VisualCAD and click here to Download
the single stroke font. Unzip and copy the file  MecSoft_Font_1.ttf to the C:

\Windows\Fonts folder.

13. The text preview will now look like this.

http://www.mecsoft.com/guest/Support%20Documents/MecSoft_Font-1.zip
http://www.mecsoft.com/guest/Support%20Documents/MecSoft_Font-1.zip
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14. Make the following adjustments to the dialog:

Allow Single Line Font: Checked
Text Size: 0.25

15. Now place in the Type in Text to Create window, replace the text VisualCAD with
the following text:

Part Number: 6001257

16. The dialog should look like this:

17. Now pick the Done button.  The dialog will close and command prompt says: Enter
start point of text.  

18. You will see the text as you move the cursor around the Viewport.

19. Enable the Grid Snap  and then select the grid point to position the text, or

0.5,2.5 in the command window  and press <Enter>.  The text
should appear like this:
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The text is actually individual curves that you can select as Control Geometry in your
machining operations.

20. To select the curves, first make sure that the option Use Preselection Highlight is
unchecked.  It is located on the System section of the Options dialog (Home tab >
Options > System).  This was covered in the Set System Options section of Exercise
#1.

21. Now select one of the curves in the text or window select all of the curves in the

text and then pick the Properties  icon from the Status Bar to display the
Properties dialog.

22. You will see that the text is actually 26 individual objects.

12.3 Other C-Plane Commands

Other C-Plane Commands

Be sure review the other C-Plane commands listed below.

1. Select the Modeling Aids  tab.

2. The C-Plane command pane is located on the right side of the ribbon bar:
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Icon Command

Immediately sets the orientation of the C-Plane to be parallel to
the plane of the currently active view.  The origin remains the
same.

Moves the origin of the C-Plane to a selected point or entered
coordinates.  The current configuration of the construction plane is
saved whenever the model is saved. 

Moves the elevation of the C-Plane along its normal
(perpendicular to the plane).  Input is a single distance and may be
positive or negative.  A positive number moves the plane towards
the positive end of the coordinate axes even if the viewing
location is along the negative axis.  All input values are treated as
an incremental distance relative to the current location of the
plane.

Rotates the C-Plane about one of the principle axes of the current
C-Plane, X, Y, or Z.  The center of rotation is the center of the plane
and not necessarily the origin. Input is 'axis,degrees'.

Three points are selected (origin, x-axis and y-axis) or entered to
re-orient the C-Plane.  The y-axis point defines the C-Plane and
the general direction of the positive y-axis. 

The C-Plane will be oriented to a selected flat plane of a geometry
object.  The pick point will become the C-Plane origin.

Two points are entered to re-orient the x-axis of the C-Plane:

Resets the C-Plane back to its default orientation relative to the
WCS and the currently active viewport.  The origin will be the WCS
origin.

This option saves the C-Plane orientation from the currently active
view.  A name must be provided for later reference when loading.

This option allows the retrieval of a saved C-Plane into the
currently active view.  A list of previously saved C-Planes is
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presented.  These saved C-Planes may also be deleted in this
option or renamed.

12.4 Orient the Part

Orient the Part

There may be times when you need to re-orient the part.  This can happen at times when
a part that you import into VisualCAD has it's WCS position skewed.  In order to work
with the part it has be oriented.

We have deliberately skewed the part from Exercise #5 Connector Block so that it no
longer lies parallel to any view.  Here is what it looks like:

 

1. The first step toward to orienting this part is to define the C-Plane.  For more about
this see the topics Orient the C-Plane and Text on a Part Face in this exercise.

2. First make sure the Grid is visible.  You can toggle the Grid on/off by selecting Hide /
Show Grid from the View Toolbar.

3. Now activate the view that allows you to see the planar face that you want to use to

orient the part by.  In this example it is Iso View 1 .
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4. Go to the Modeling Aids  tab and select the C-Plane by 3 Points

 command.

5. Activate the End Point Snap  from the Status Toolbar and select the end points
in the order shown below:

The C-Plane will orient to the 3 points selected.

6. Now right-click anywhere in the Viewport (do not select any geometry) and select

Align to C-Plane.  This will align Iso View 1  parallel to the C-Plane.
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The C-Plane will align to the Viewport.

7. Now we can orient the part.  Select the part and go to the Modify / Transform

 tab and select the Part Orient ...  command.

8. This will display the Orient entire part dialog.  Pick the option to Set as current view
direction.
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9. Pick OK and the part appears to disappear from the Viewport.

10. Now pick the Fit View  icon from the View Toolbar.  The part will appear with
the WCS oriented in/on the center of the face that we used to align the C-Plane 
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11. Now activate the Top View  and pick the Fit View  icon from the
View Toolbar.

12. Repeat this for the Front View  and the Right View . 
Remember that you have to activate the Viewport before the View Toolbar will
display.  Left-click anywhere within the Viewport to activate it.
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13. Activate Iso View 1  again and this time select the Iso View  icon
from the View Toolbar to orient this Viewport.

Great!  You have the part oriented orthographically (i.e., Top, Front, Right).

14. However, the part is still not oriented like the original part as shown below.  You
see that the length of the part was oriented along the Y Axis and the WCS was
positioned at the center of the front view.  Let's show you some additional
commands to fix that.

15. Activate Iso View 1  and then from the Status Toolbar, toggle the

Graphic Manipulator  On.

16. Now select the part to see the Graphic Manipulator displayed.  
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17. Pick the Z Rotation arc of the Graphic Manipulator  to display the input window,
enter 90 and then press <Enter>.

18. Now you see the part is rotated so press <Enter> to accept the rotation.
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Great where almost there!

To move the WCS to the original location which was centered on the front face of the
part we need to create a point there to move from.

19. Zoom in on the front face of the part.

20. From the Curve Modeling  tab select the command Create mid point

between two points .

21. Activate the End Point Snap  from the Status toolbar.

22. Select the two diagonal end points on the front face of the part as shown.

23. You can now toggle the Graphic Manipulator  off.

24. With the point created, window select the entire part (and point) or simply press
<Ctrl+A>.

25. From the Modify / Transform  tab select the Move by mouse 
command.

26. The command prompt says: Pick from point or enter coordinates x,y and z.  Make

sure the End Point Snap  is active from the Status Toolbar and select the point
you just created.
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27. Now the command prompt says: Pick to point or enter coordinates x,y and z.  In the

command window enter 0,0,0  and then press <Enter>.

You will see that the part moved to the WCS origin.  Now press <Enter> again to
accept the move.

28. Now the part is aligned correctly accept for the C-Plane.  Previously the C-Plane was
aligned to the XY plane of WCS.  

Here is a neat trick to fix that:

29. Activate the Top View .



#8: Using Construction Planes 255

© 2026 Mecsoft Corporation

30. Now double-left-click on the Top View  tab.  This will change the display
to one Viewport set to the Top View.

31. Now right-click on the Top View  tab and select Quad Viewport.



VisualCAD 2026 Exercise Guide256

© 2026 Mecsoft Corporation

You see that Iso View 1  inherited the C-Plane of the Top View because
that was the active View when you selected Quad Viewport.

32. Save the file as Construction_Planes_Completed.vcp.

Congratulations on completing this exercise!
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Find More Resources

Download this PDF Guide for a list of the available VisualCAD/CAM Resources.

2025 VisualCAD/CAM Resource Guide

The 2026 VisualCAD/CAM Resource Guide!

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Prefer Printed Documentation? Click Here!

What's New |  Quick Start Play List

https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2026.pdf
https://www.youtube.com/playlist?list=PLx9G05pFm0QISEAjFqPkrNRyUTOYw9ZRZ
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